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Copyright
Copyright © 2006 Nokia. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form
without the prior written permission of Nokia is prohibited.

Nokia, Nokia Connecting People, and Nokia X and Y are trademarks or registered trademarks of Nokia
Corporation. Other product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and
improvements to any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental,
consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this
document. Nokia reserves the right to revise this document or withdraw it at any time without prior notice.

The availability of particular products may vary by region.

IMPORTANT
This document is intended for use by qualified service personnel only.
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Warnings and cautions

Warnings
• IF THE DEVICE CAN BE INSTALLED IN A VEHICLE, CARE MUST BE TAKEN ON INSTALLATION IN VEHICLES FITTED

WITH ELECTRONIC ENGINE MANAGEMENT SYSTEMS AND ANTI-SKID BRAKING SYSTEMS. UNDER CERTAIN FAULT
CONDITIONS, EMITTED RF ENERGY CAN AFFECT THEIR OPERATION. IF NECESSARY, CONSULT THE VEHICLE DEALER/
MANUFACTURER TO DETERMINE THE IMMUNITY OF VEHICLE ELECTRONIC SYSTEMS TO RF ENERGY.

• THE PRODUCT MUST NOT BE OPERATED IN AREAS LIKELY TO CONTAIN POTENTIALLY EXPLOSIVE ATMOSPHERES,
FOR EXAMPLE, PETROL STATIONS (SERVICE STATIONS), BLASTING AREAS ETC.

• OPERATION OF ANY RADIO TRANSMITTING EQUIPMENT, INCLUDING CELLULAR TELEPHONES, MAY INTERFERE
WITH THE FUNCTIONALITY OF INADEQUATELY PROTECTED MEDICAL DEVICES. CONSULT A PHYSICIAN OR THE
MANUFACTURER OF THE MEDICAL DEVICE IF YOU HAVE ANY QUESTIONS. OTHER ELECTRONIC EQUIPMENT MAY
ALSO BE SUBJECT TO INTERFERENCE.

• BEFORE MAKING ANY TEST CONNECTIONS, MAKE SURE YOU HAVE SWITCHED OFF ALL EQUIPMENT.

Cautions
• Servicing and alignment must be undertaken by qualified personnel only.

• Ensure all work is carried out at an anti-static workstation and that an anti-static wrist strap is worn.

• Ensure solder, wire, or foreign matter does not enter the telephone as damage may result.

• Use only approved components as specified in the parts list.

• Ensure all components, modules, screws and insulators are correctly re-fitted after servicing and
alignment.

• Ensure all cables and wires are repositioned correctly.

• During testing never activate the GSM transmitter without a proper antenna load, otherwise the GSM PA
may be damaged.
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ESD protection
Nokia requires that service points have sufficient ESD protection (against static electricity) when servicing
the phone.

Any product of which the covers are removed must be handled with ESD protection. The SIM card can be
replaced without ESD protection if the product is otherwise ready for use.

To replace the covers ESD protection must be applied.

All electronic parts of the product are susceptible to ESD. Resistors, too, can be damaged by static electricity
discharge.

All ESD sensitive parts must be packed in metallized protective bags during shipping and handling outside
any ESD Protected Area (EPA).

Every repair action involving opening the product or handling the product components must be done under
ESD protection.

ESD protected spare part packages MUST NOT be opened/closed out of an ESD Protected Area.

For more information and local requirements about ESD protection and ESD Protected Area, contact your local
Nokia After Market Services representative.

RM-180
ESD protection Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page v
Copyright © 2006 Nokia. All rights reserved.



Care and maintenance
This product is of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfil any warranty obligations and to enjoy this product for many years.

• Keep the phone and all its parts and accessories out of the reach of small children.

• Keep the phone dry. Precipitation, humidity and all types of liquids or moisture can contain minerals that
will corrode electronic circuits.

• Do not use or store the phone in dusty, dirty areas. Its moving parts can be damaged.

• Do not store the phone in hot areas. High temperatures can shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

• Do not store the phone in cold areas. When it warms up (to its normal temperature), moisture can form
inside, which may damage electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the phone.

• Do not paint the phone. Paint can clog the moving parts and prevent proper operation.

• Use only the supplied or an approved replacement antenna. Unauthorised antennas, modifications or
attachments could damage the phone and may violate regulations governing radio devices.

All of the above suggestions apply equally to the product, battery, charger or any accessory.
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Company Policy
Our policy is of continuous development; details of all technical modifications will be included with service
bulletins.

While every endeavour has been made to ensure the accuracy of this document, some errors may exist. If
any errors are found by the reader, NOKIA MOBILE PHONES Business Group should be notified in writing/e-
mail.

Please state:

• Title of the Document + Issue Number/Date of publication

• Latest Amendment Number (if applicable)

• Page(s) and/or Figure(s) in error

Please send to:
NOKIA CORPORATION

Nokia Mobile Phones Business Group

Nokia Customer Care

PO Box 86

FIN-24101 SALO

Finland

E-mail: Service.Manuals@nokia.com
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Battery information
Note: A new battery's full performance is achieved only after two or three complete charge and
discharge cycles!

The battery can be charged and discharged hundreds of times but it will eventually wear out. When the
operating time (talk-time and standby time) is noticeably shorter than normal, it is time to buy a new battery.

Use only batteries approved by the phone manufacturer and recharge the battery only with the chargers
approved by the manufacturer. Unplug the charger when not in use. Do not leave the battery connected to
a charger for longer than a week, since overcharging may shorten its lifetime. If left unused a fully charged
battery will discharge itself over time.

Temperature extremes can affect the ability of your battery to charge.

For good operation times with Ni-Cd/NiMh batteries, discharge the battery from time to time by leaving the
product switched on until it turns itself off (or by using the battery discharge facility of any approved accessory
available for the product). Do not attempt to discharge the battery by any other means.

Use the battery only for its intended purpose.

Never use any charger or battery which is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object (coin, clip or
pen) causes direct connection of the + and - terminals of the battery (metal strips on the battery) for example
when you carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the battery
or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, will reduce
the capacity and lifetime of the battery. Always try to keep the battery between 15°C and 25°C (59°F and 77°
F). A phone with a hot or cold battery may temporarily not work, even when the battery is fully charged.
Batteries' performance is particularly limited in temperatures well below freezing.

Do not dispose of batteries in a fire!

Dispose of batteries according to local regulations (e.g. recycling). Do not dispose as household waste.
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 Product selection
RM-180 is a tri-band GSM phone, supporting EGSM900/1800/1900 bands.

According to GSM standard 05.05 it responds to class 4 (max. 2 W) in EGSM 900, class 1 (1 W) in GSM 1800 and
class 1 in GSM 1900. The device supports EGPRS (EDGE) class B as well as Bluetooth 2.0 + EDR (Enhanced Data
Rate) standard. The handset has a full phase 2 Type Approval and it complies with the GSM Type Approval.
RM-180 also has a full CE approval and FCC (Federal Communications Commission) approval.

RM-180 is an MMS (Multimedia Messaging Service) enabled phone with a large bright colour display and an
integrated 2.0 megapixel rear camera.

The MMS implementation follows the OMA (Open Mobile Alliance) MMS standard release 1.2.

WAP 2.0 compatible browser supports XHTML Mobile Profile (MP) and uses a TCP/IP stack to communicate
with a gateway in network.

RM-180 use a Symbian 8.0a operating system and support also MIDP (Mobile Information Device Profile) Java
2.0 & CLDC 1.1 (Connected Limited Device Configuration), providing a good platform for 3rd party applications.

Figure 1 View of RM-180

 RM-180 product features and sales package

Imaging and video
• 2 megapixel camera (1600 x 1200 pixels) with 20x digital zoom

• Dedicated shutter key and camera activation slide

• Integrated flash (operating range up to 1.5 m)

• Flash modes: on, off, automatic, and anti red-eye

• Advanced camera modes: still, sequence, video
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• Six possible capture scene settings including scenery, portrait, night and sports

• Settings, brightness adjustment, image quality, self-timer, white balance settings and colour tones

• Video and still image editors

• Movie Director for automated video production

Bearers & transport
• GPRS class B, multislot class 10

• EGPRS multislot class 10

• USB 2.0

• Bluetooth 2.0

Software platform
• Nokia Series 60 release 2.8

• Symbian 8.1

Connectivity
• Integrated Bluetooth wireless technology v.2.0

• USB 2.0 full speed via Pop-Port™ interface

• Nokia PC Suite connectivity via USB and Bluetooth wireless technology

• Local synchronisation of contacts and calendar to a compatible PC using compatible connection

• Remote over-the-air synchronisation

• Send and receive images, video clips, graphics, and business cards via Bluetooth wireless technology

• Profiles with Bluetooth connectivity: Basic Printing Profile (BPP) using Image Print or Info Print
applications, Human Interface Device Profile (HID) using Nokia Wireless Keyboard application

Sales package
• RM-180 transceiver

• HS-3 stereo headset

• CA-53 USB connectivity cable

• MU-1 RS-MMC 64 MB with adapter

• BL-5C Li-ion battery cell

• AC-3 charger

• User guide

• CD-ROM (with PC-Suite)

• Carry strap

 Mobile enhancements

Table 1 Audio

Enhancement Type

Boom mono headset HDB-4

Fashion stereo headset HS-3

Mono headset HS-5
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Enhancement Type

Stereo headset HDS-3

Inductive loopset LPS-4

Wireless headset HDW-3

HS-4W

HS-11W

Wireless clip-on headset HS-21W

Wireless image headset HS-13W

Audio adapter AD-15

TTY adapter HDA-10

Music stand MD-1

Table 2 Car

Enhancement Type

Mobile charger DC-4

Headrest handsfree BHF-3

Basic handsfree HF-3

Advanced car kit (sales pack) CK-7W

Wireless car kit CK-1W

Wireless plug-in car handsfree HF-6W

Universal holder CR-39

Table 3 Carrying

Enhancement Type

Carrying case CNT-676

Table 4 Data

Enhancement Type

USB data cable DKU-2

Connectivity cable CA-53

Wireless GPS module LD-1W

RS multimedia card 64 MB MU-1

RS multimedia card 128 MB MU-2

RS multimedida card 256 MB MU-9

RS multimedia card 512 MB MU-12
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Table 5 Imaging

Enhancement Type

Nokia image album PD-1

Nokia remote camera PT-6

Table 6 Messaging

Enhancement Type

Nokia digital pen SU-1B

Bluetooth QWERTY keypad SU-8W

Table 7 Power

Enhancement Type

Battery 970mAh Li-ion BL-5C

Compact charger AC-3

Travel charger AC-4

Charging adapter CA-44

 Technical specifications

Transceiver general specifications

Unit Dimensions (L x W x T)
(mm)

Weight (g) Volume (cm3)

Transceiver with BL-5C
900mAh li-ion battery
back

108.8 x 53 x 21.8 126 95.9

Main RF characteristics for triple-band phones

Parameter Unit

Cellular system GSM/EGSM900,GSM1800/1900

Rx frequency band EGSM900: 925 - 935 MHz

GSM900: 935 - 960MHz

GSM1800: 1805 - 1880 MHz

GSM1900: 1930 - 1990 MHz

Tx frequency band EGSM900: 880 - 890MHz

GSM900: 890 - 915MHz

GSM1800: 1710 - 1785 MHz

GSM1900: 1850 - 1910 MHz
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Parameter Unit

Output power GSM900: +5 … +33dBm/3.2mW … 2W

GSM1800: +0 … +30dBm/1.0mW … 1W

GSM1900: +0 … +30dBm/1.0mW … 1W

Number of RF channels GSM900: 125

GSM1800: 375

GSM1900: 300

Channel spacing 200KHz

Number of Tx power levels GSM900: 15

GSM1800: 16

GSM1900: 16

Battery endurance

Battery Capacity (mAh) Talk time Stand-by

BL-5C 970 up to 3.5* hrs up to 11* days

*Variation in operation times will occur depending on the SIM card, network settings and usage. Talk time
is increased by up to 30% if half rate is active and reduced by 5% if enhanced full rate is active.

Charging times

AC-4 AC-3

1 h 15 min 2 h 45 min

Environmental conditions

Environmental condition Ambient temperature Notes

Normal operation -15oC...+55oC Specifications fulfilled

Reduced performance -25oC...-15oC

+55oC...+70oC

Operational for shorts periods
only

Intermittent operation -40oC...-15oC

+70oC...+85 oC

Operation not guaranteed but an
attempt to operate does not
damage the phone.

No operation or storage <-40oC...>+85oC No storage or operation: an
attempt may damage the phone.

Charging allowed -25oC...+50oC

Long term storage conditions 0oC...+85oC
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 Parts lists

Mechanical spare parts list

Note: For Nokia product codes, please refer to the latest Service Bulletins on the Partner Website (PWS).

To ensure you are always using the latest codes, please check the PWS on a daily basis.

Bold = ASSY

ITEM/ CIRCUIT
REF. QTY PART NAME

I001 1 A COVER ASSY

I002 1 MMC DOOR

I003 1 KEYMAT

I004 6 SCREW RF 1.8X9

1 UI FRAME ASSY

I005 1 UI FRAME

I006 1 BEZEL GROUND SPRING

I007 4 LCD GROUND PIN

I008 1 EARPIECE

I009 1 EARPIECE ADHESIVE

1 1NC UI PWB ASSY

I010 1 UI PWB

I011 1 SWITCH

I012 1 DOMESHEET

I013 1 BB SHIELD ASSEMBLY

I014 1 LCD AM 176X208

I017 1 ENGINE MODULE

I018 1 GSM PA SHIELDING LID

I020 1 TAHVO SHIELDING LID

I021 1 HINKU / VINKU SHIELDING LID

I022 1 FLASH SHIELDING LID ASSY

I023 1 CAMERA MODULE 2MP

1 CHASSIS ASSY

I024 1 CHASSIS

I025 1 DC JACK 2mm

I026 1 MICROPHONE

I027 1 VIBRA MOTOR

I028 1 IHF SPEAKER
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ITEM/ CIRCUIT
REF. QTY PART NAME

I029 1 IHF TOP PAD

I030 1 SLIDE DETECT LEVER

I031 1 SIM FLAP

I032 1 BT ANTENNA ASSY

I033 1 IHF COVER ASSY

I034 1 LED FLASH

I035 1 CAMERA REAR BEZEL ASSY

I036 1 CAMERA REAR BEZEL ADHESIVE

1 ANTENNA ASSY

I037 1 ANTENNA RADIATOR GSM

I039 1 ANTENNA MODULE

I040 1 TYPE LABEL

I041 1 ANTENNA COVER

I042 1 POWER BUTTON

I043 1 BATTERY COVER

Component parts list (1YA_02.1f)

Item Side Grid ref. Type Description and value

A7003 Bot D 10
SHIELD_ROLF_R
F

SHIELD ASSEMBLY
HINKU/VINKU
040-010018 ~ ~

A7004 Bot B 7
SHIELD_ROLF_V
CO SHIELD ROLF VCO ~ ~

A7005 Bot E 12
SHIELD_ROLF_F
LASH

SHIELD ROLF GSM
FLASH ~ ~

A7006 Bot D 6
SHIELD_ROLF_T
AHVO SHIELD ROLF TAHVO ~ ~

A7008 Bot H 17
SHIELD_ROLF_
GSM_PA SHIELD ROLF GSM PA ~ ~

B2200 Top D 6
CRYSTAL_3.3X1
.6_H0.9

CRYSTAL 32.768KHZ
+-20PPM 12.5PF

32.768kH
z ~

C1470 Bot D 15 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C1471 Bot F 18 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C1472 Bot F 6 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

RM-180
Nokia Customer Care Parts Lists and Component Layouts

Page 2 –8 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



Item Side Grid ref. Type Description and value

C1473 Bot G 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C1479 Bot E 14 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C1480 Bot D 14 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C1481 Top D 20 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C1482 Top D 20 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C1483 Top E 6 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C1484 Bot E 12 0805C
CHIPCAP X5R 4U7 K 6V3
0805 4u7 6V3

C1485 Bot E 13 1206C_TDK
CHIPCAP 2U2 K 25V
1206 2u2 25V

C1486 Bot E 13 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C1487 Bot C 15 0402C Chipcap 5% NP0 10p 50V

C1488 Bot C 15 0402C Chipcap 5% NP0 10p 50V

C1489 Top E 19 0402C Chipcap 5% NP0 22p 50V

C1490 Top E 20 0402C Chipcap 5% NP0 22p 50V

C1491 Top D 19 0402C Chipcap 5% NP0 22p 50V

C2000 Bot C 3 0402C Chipcap 5% NP0 27p 50V

C2002 Bot F 3 0603C
CHIPCAP X5R 2U2 K 6V3
0603 2u2 6V3

C2003 Bot F 3 0402C
CERCAP X7R 22N K 16V
0402 22n 16V

C2004 Bot G 3 0402C
CERCAP X7R 22N K 16V
0402 22n 16V

C2005 Bot F 2 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2006 Bot G 2 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2007 Bot G 2 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2008 Bot G 2 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2009 Bot G 2 0402C
Chipcap X7R 10% 16V
0402 10n 16V
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Item Side Grid ref. Type Description and value

C2010 Bot G 3 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2011 Top F 1 0402C
CHIPCAP NP0 270P J
25V 0402 270p 25V

C2012 Bot C 3 0603C_H0.95
CHIPCAP X5R 1U K 25V
0603 1u0 25V

C2070 Bot G 14 0402C Chipcap 5% NP0 15p 50V

C2072 Bot I 15 0402C Chipcap 5% NP0 15p 50V

C2100 Bot F 2 0402C
CHIPCAP X7R 15N K
16V 0402 15n 16V

C2101 Bot F 2 0402C
CHIPCAP X7R 15N K
16V 0402 15n 16V

C2102 Bot F 2 0603C
CHIPCAP X5R 2U2 K 6V3
0603 2u2 6V3

C2103 Top E 6 0402C Chipcap 5% X7R 1n0 50V

C2104 Top E 6 0402C Chipcap 5% X7R 1n0 50V

C2105 Top A 6 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2106 Top A 6 0402C Chipcap 5% NP0 27p 50V

C2107 Top A 6 0402C Chipcap 5% NP0 27p 50V

C2108 Top B 6 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2109 Top B 7 0402C Chipcap 5% NP0 27p 50V

C2110 Top A 7 0402C Chipcap 5% NP0 27p 50V

C2200 Top C 5 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2201 Top C 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2202 Top D 6 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2203 Top D 6 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2204 Top E 6 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2205 Top D 5 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2206 Top D 6 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2207 Top E 6 0402C
Chipcap X7R 10% 50V
0402 1n0 50V
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Item Side Grid ref. Type Description and value

C2208 Top D 7 0402C Chipcap 5% NP0 27p 50V

C2209 Top D 7 0402C Chipcap 5% NP0 22p 50V

C2210 Top B 7 0603C
CHIPCAP X5R 1U K 16V
0603 1u0 16V

C2211 Top B 6 0805C
CHIPCAP X5R 4U7 K 10V
0805 4u7 10V

C2212 Top B 6 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2213 Top C 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2214 Top C 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2215 Top C 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2216 Top D 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2217 Top D 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2219 Top D 6 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2220 Top B 6 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2221 Top B 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2222 Top B 6 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2223 Top C 5 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2224 Top D 5 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2225 Top D 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2226 Top D 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2227 Top B 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2228 Top C 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2230 Top D 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V
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C2231 Top A 5 0805C
CHIPCAP X5R 10U M
6V3 0805 10U 6V3

C2232 Top C 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2234 Top D 6 0402C Chipcap 5% NP0 27p 50V

C2235 Top D 6 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2237 Top E 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2240 Top B 2 0402C Chipcap 5% NP0 12p 50V

C2241 Top G 3 0402C Chipcap 5% NP0 12p 50V

C2242 Top E 5 0402C Chipcap 5% NP0 12p 50V

C2243 Top I 3 0402C Chipcap 5% NP0 12p 50V

C2244 Top G 1 0402C Chipcap 5% NP0 12p 50V

C2300 Bot D 5 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2301 Bot D 6 0805C
CHIPCAP X5R 22U M
6V3 0805 22u 6V3

C2302 Bot D 5 0805C
CHIPCAP X5R 22U M
6V3 0805 22u 6V3

C2303 Bot D 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2304 Bot C 6 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2307 Bot E 7 0603C
CHIPCAP X5R 2U2 K 6V3
0603 2u2 6V3

C2309 Bot E 5 0805C
CHIPCAP X5R 22U M
6V3 0805 22u 6V3

C2312 Bot E 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2313 Bot E 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2314 Top G 7 0805C
CHIPCAP X5R 4U7 M
25V 0805 4u7 25V

C2315 Top G 6 0805C
CHIPCAP X5R 4U7 M
25V 0805 4u7 25V

C2316 Bot C 6 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2700 Bot H 7 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V
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C2800 Top H 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2801 Top H 5 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2802 Top I 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2803 Top I 5 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2804 Top G 4 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2805 Top G 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2806 Top G 5 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2807 Top H 5 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2808 Top G 4 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2809 Top H 5 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2810 Top G 5 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2811 Top I 5 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2812 Top H 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2813 Top I 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2814 Top I 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C3000 Top G 7 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C3001 Top I 5 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C3002 Top G 6 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C3003 Top I 5 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C3004 Top H 1 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V
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C3005 Top I 1 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C3006 Top I 2 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C3007 Top H 1 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C3008 Top I 2 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4200 Top D 2 0805C
CHIPCAP X5R 22U M
6V3 0805 22u 6V3

C4201 Top D 1 0805C
CHIPCAP X5R 22U M
6V3 0805 22u 6V3

C4203 Top B 2 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C4204 Top C 2 0402C Chipcap 5% NP0 100p 50V

C4205 Top B 5 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C4206 Top B 1 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C4400 Top D 19 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C4401 Top D 19 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C4402 Top D 19 0402C Chipcap 5% NP0 27p 50V

C4800 Top D 4 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4801 Top E 2 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C4802 Top G 5 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4803 Top G 5 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4804 Top E 5 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4805 Top G 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4806 Top E 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4807 Top D 4 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V
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C4808 Top G 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4809 Top G 4 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4810 Top F 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4811 Top E 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4812 Top E 5 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4813 Top G 4 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C4814 Top E 6 0402C Chipcap 5% NP0 22p 50V

C5000 Top B 2 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C5001 Top D 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C5002 Top D 4 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C5003 Top B 2 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C5004 Top D 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C5005 Top D 5 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C5200 Bot H 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C7501 Bot C 11 0402C Chipcap 5% NP0 18p 50V

C7503 Bot C 11 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C7504 Bot C 11 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C7505 Bot B 11 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C7507 Bot C 10 0402C Chipcap 5% NP0 18p 50V

C7508 Bot B 10 0402C Chipcap 5% NP0 18p 50V

C7509 Bot C 11 0402C Chipcap +-0.25pF NP0 2p7 50V

C7512 Bot G 19 0402C Chipcap 5% NP0 39p 50V

C7513 Bot B 11 0402C
Chipcap X7R 10% 25V
0402 4n7 25V
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C7514 Bot G 19 0402C Chipcap 5% NP0 39p 50V

C7515 Bot C 9 0402C Chipcap 5% NP0 10p 50V

C7516 Bot C 9 0402C Chipcap 5% NP0 150p 50V

C7518 Bot E 9 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C7520 Bot C 11 0402C Chipcap 5% NP0 18p 50V

C7522 Bot C 9 0402C Chipcap 5% NP0 150p 50V

C7523 Bot G 18 0402C Chipcap +-0.25pF NP0 5p6 50V

C7524 Bot B 9 0603C
CHIPCAP NP0 2N2 G
16V 0603 2n2 16V

C7525 Bot G 18 0402C Chipcap +-0.25pF NP0 5p6 50V

C7527 Bot B 10 0402C Chipcap 5% NP0 100p 50V

C7528 Bot B 10 0402C Chipcap 5% NP0 22p 50V

C7529 Bot D 9 0402C Chipcap 5% NP0 100p 50V

C7530 Bot B 11 0402C
Chipcap X7R 10% 16V
0402 8n2 16V

C7531 Bot C 10 0402C Chipcap 5% NP0 22p 50V

C7532 Bot B 11 0402C
Chipcap X7R 10% 16V
0402 8n2 16V

C7533 Bot C 8 0402C
CERCAP X7R 22N K 16V
0402 22n 16V

C7534 Bot B 11 0402C
Chipcap X7R 10% 16V
0402 8n2 16V

C7536 Bot B 11 0402C
Chipcap X7R 10% 16V
0402 8n2 16V

C7541 Bot D 9 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C7543 Bot E 10 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C7545 Bot I 17 0402C Chipcap +-0.25pF NP0 4p7 50V

C7547 Bot D 9 0402C Chipcap +-0.25pF NP0 1p8 50V

C7548 Bot D 8 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C7549 Bot D 9 0402C Chipcap 5% NP0 100p 50V

C7550 Bot E 8 0402C Chipcap +-0.25pF NP0 2p7 50V

C7552 Bot D 8 0402C Chipcap +-0.25pF NP0 2p7 50V

C7553 Bot D 8 0402C
Chipcap X7R 10% 16V
0402 8n2 16V
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C7554 Bot B 6 0402C Chipcap +-0.25pF NP0 4p7 50V

C7555 Bot B 6 0402C
CHIPCAP NP0 0P5 C 50V
0402 0p5 50V

C7556 Bot G 16 0402C Chipcap 5% NP0 10p 50V

C7558 Bot E 10 0402C Chipcap 5% X7R 1n0 50V

C7559 Bot I 18 0402C Chipcap +-0.25pF NP0 1p0 50V

C7560 Bot E 9 0402C
Chipcap X7R 10% 25V
0402 4n7 25V

C7561 Bot G 17 0402C Chipcap +-0.25pF NP0 4p7 50V

C7563 Bot G 17 0402C Chipcap +-0.25pF NP0 4p7 50V

C7564 Bot H 18 0402C Chipcap 5% X7R 1n0 50V

C7567 Bot E 10 0402C Chipcap 5% NP0 15p 50V

C7568 Bot E 8 0402C Chipcap 5% NP0 150p 50V

C7569 Bot G 17 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7570 Bot E 9 0402C Chipcap 5% NP0 18p 50V

C7571 Bot B 6 0402C
CHIPCAP NP0 330P J
50V 0402 330p 50V

C7573 Bot A 6 0603C
CHIPCAP NP0 2N2 G
16V 0603 2n2 16V

C7575 Bot E 10 0402C Chipcap 5% NP0 15p 50V

C7577 Bot E 10 0402C Chipcap 5% NP0 15p 50V

C7581 Bot G 19 0402C Chipcap 5% NP0 39p 50V

C7582 Bot D 9 0402C Chipcap 5% NP0 100p 50V

C7584 Bot G 18 0402C Chipcap 5% NP0 39p 50V

C7593 Bot G 16 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7596 Bot C 11 0402C Chipcap +-0.25pF NP0 2p7 50V

C7597 Bot F 14
TANT_6.3X3.5_
H2.0

CHIPTCAP 100U M 14V
6X3.2X2 100u_14V 14V

C7598 Bot B 8 0402C
CHIPCAP NP0 0P5 C 50V
0402 0p5 50V

C7599 Top D 20 0402C
CHIPCAP X7R 33N K
10V 0402 33n 10V

C7600 Top B 20 0603C
CHIPCAP X5R 2U2 K 6V3
0603 2u2 6V3

C7601 Top B 20 0603C
CHIPCAP X5R 2U2 K 6V3
0603 2u2 6V3
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C7602 Top B 2 0402C Chipcap 5% NP0 12p 50V

C7604 Bot F 3 0402C
CHIPCAP X5R 100N K
10V 0402 100n 10V

C7605 Bot F 3 0402C
CHIPCAP X5R 100N K
10V 0402 100n 10V

C7606 Bot H 2 0402C Chipcap 5% NP0 10p 50V

C7607 Bot H 2 0402C Chipcap 5% NP0 10p 50V

C7608 Bot H 2 0402C Chipcap 5% NP0 10p 50V

C7609 Bot G 2 0402C Chipcap 5% NP0 10p 50V

C7612 Bot C 4 0402C
CHIPCAP X5R 100N K
10V 0402 100n 10V

C7613 Bot F 3 0402C
CHIPCAP X5R 100N K
10V 0402 100n 10V

C7615 Bot C 9 0402C Chipcap +-0.25pF NP0 4p7 50V

C7616 Bot F 3 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C7617 Bot F 3 0402C Chipcap 5% NP0 100p 50V

C7618 Bot F 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

D2800 Top H 4 uBGA_289
RAP V2.21E-PA C027
UBGA ~ ~

D3000 Top H 7

PBFREEBGA40_
64MB_54MHZ_
MAX

FLASH 4MX16 1.8/1.8V
VFBGA44 PBFREE 4MX16 ~

D3001 Top H 2
WBGA_60_8.1X
6.6_H0.9

SDRAM 4MX16 1.8V/
1.8V WBGA60 4Mx16 ~

D4800 Top E 4 uBGA_289

HELEN3 PS1.1E
F761991A C027
UBGA289 ~ ~

D5000 Top B 4 FBGA133

COMBO 512 DDR +
512M NAND FBGA133
PBFREE

32Mx16/6
4Mx8 ~

D5001 Bot D 4
LGA_BTHFM_ES
3.6

BTHFM1.0_ES3.6
MODULE ~ ~

F2000 Bot C 2
0603_FUSE_AV
X2MATS SM FUSE F 2.0A 32V 2A ~

G2200 Top F 6
BATTER_RB414
H

RTC CAPACITOR 15UAH
2.6/3.3V 414-SIZE 3V3 ~

G7500 Bot B 9
VCO_FDK_WB0
02

VCO 3610-4340MHZ
2.7V 15MA

3610-434
0MHz ~
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G7501 Bot C 9
NKG3176B_H1.
0

VCTCXO 38.4MHZ 2.5V
2MA 38.4MHz ~

G7502 Bot B 7
VCO_FDK_WB0
02

VCO 3296-3980MHZ
2.7V 20MA EGSM

3296-398
0MHz ~

L1473 Bot E 11 CHOKE_SER300
CHOKE 3.3UH 0R252
0A82 310 CASE SIZE 3u3H ~

L1474 Top E 7 0805_BLM21
FERR.BEAD 0R03 42R/
100MHZ 3A 0805

42R/
100MHz ~

L1479 Bot C 15 0402L
CHIP COIL 27N J
Q27/800M 0402 27nH ~

L1480 Bot C 15 0402L
CHIP COIL 27N J
Q27/800M 0402 27nH ~

L2000 Bot C 2 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L2001 Bot F 2
0405_2_MATS
U

CHIP BEAD ARRAY
2X1000R 0405

2x1000R/
100MHz ~

L2002 Bot G 2
0405_2_MATS
U

CHIP BEAD ARRAY
2X1000R 0405

2x1000R/
100MHz ~

L2003 Bot G 2
0405_2_MATS
U

CHIP BEAD ARRAY
2X1000R 0405

2x1000R/
100MHz ~

L2100 Top E 19
0405_2_MATS
U

CHIP BEAD ARRAY
2X1000R 0405

2x1000R/
100MHz ~

L2101 Top B 6 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L2102 Bot F 18 COIL_0603CS
CHIP COIL 56N J
Q38/250MHZ 0603 56nH ~

L2103 Bot F 18 COIL_0603CS
CHIP COIL 56N J
Q38/250MHZ 0603 56nH ~

L2104 Top B 6 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L2105 Top B 6 0402L_XL
FERRITE BEAD 220R
0R45 0.3A 0402

220R/
100MHz ~

L2106 Top A 6 0402L_XL
FERRITE BEAD 220R
0R45 0.3A 0402

220R/
100MHz ~

L2202 Top E 7 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L2203 Top C 7 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L2204 Top D 7 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~
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L2205 Top B 5 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L2206 Top B 7 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L2301 Bot E 6 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L2302 Bot D 5 CHOKE_SER400
CHOKE 10U 0.8A 0R24
4X4X1.8 10uH ~

L2304 Top G 7
CHOKE_SER300
_H1.5

CHOKE 22U M 0R7
0.35A 3.0x3.0x1.5 22uH ~

L4200 Top C 2 CHOKE_SER400
CHOKE 10U 0.8A 0R24
4X4X1.8 10uH ~

L4201 Top E 2 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L4400 Top D 19 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L4401 Top D 19 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L5200 Bot H 7 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L7502 Bot D 8 0402L
CHIP COIL 100N J
Q16/300M 0402 100nH ~

L7503 Bot E 10 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L7504 Bot H 19 0402L
CHIP COIL 47N J
Q23/800MHZ 0402 47nH ~

L7506 Bot H 18 0402L
CHIP COIL 12N J
Q31/800M 0402 12nH ~

L7516 Bot G 16 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L7517 Bot E 8 0402L
CHIP COIL 1N5 +-0N3
Q33/800M 0402 1n5H ~

L7518 Bot G 3 COIL_LK_1608
CHIP COIL 68NH J
Q12/100MHZ 0603 68nH ~

N1470 Bot G 7 LLP6
REG LP3990YDX-1.5V
LLP-6 ~ 1.5V

N1471 Bot E 13 SON3024_8
STEP-UP DC/DC CONV
SON3024-8 ~ ~

N1472 Bot E 14
USMD5_1.47X1
.04_H0.675

VREG LP3985ITLX-2.8
NOPB USMD5 ~ 3V
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N1474 Top D 20 TFBGA_42

14XLEVEL SHIFTER
ST16C32245TBR
uTFBGA42 ~ ~

N2200 Top C 6 TFBGA_108
RETU 3.02 TSA1GJWE
TFBGA108 ~ ~

N2300 Bot D 7
TFBGA_84_6.1
5X6.15

TAHVO V5.2 LF
TFBGA84 ~ ~

N2301 Top G 6
USMD8_1.69X1
.69

WHITE LED DRIVER
4LEDS 500MW 8BUMP
USMD8 ~ ~

N4200 Top D 1
USMD_10_2.45
8X1.899

DC/DC CONV
LM3661-1.40V/1.05V
NOPB ~ ~

N4201 Top B 2
USMD5_1.468X
1.036

REG+ LP3999ITLX 1.8V
150MA NOPB ~ 1.8V

N7500 Bot C 11
TFBGA_84_6.1
5X6.15

RF ASIC HINKU310A
TFBGA84 ~ ~

N7501 Bot E 9 TFBGA64_H1.2
RF ASIC VINKU314A
TFBGA64 ~ ~

N7502 Bot H 17 RITSA_PA_REL3
PW AMP RF9292E9.2
QUADBAND ~ ~

N7505 Top C 20 LLP_6
REG LP3981YDX 2.8/
NOPB 0.3A LLP-6 ~ 2.8V

R1470 Top G 4 0402R Resistor 5% 63mW 100R ~

R1471 Top G 4 0402R Resistor 5% 63mW 100R ~

R1472 Top F 3 0402R Resistor 5% 63mW 3k3 ~

R1473 Top F 3 0402R Resistor 5% 63mW 3k3 ~

R1474 Top G 5 0402R Resistor 5% 63mW 33R ~

R1475 Bot F 7 0402R Resistor 5% 63mW 470k ~

R1486 Top E 20 0402R Resistor 5% 63mW 15R ~

R1487 Bot E 12 0402R
CHIPRES 0W06 6R8 J
0402 6R8 ~

R1488 Top D 19 0402R Resistor 5% 63mW 33R ~

R1489 Bot E 13 0402R Resistor 5% 63mW 3k3 ~

R1490 Top E 20 0402R
Chipres 0W06 jumper
0402 0R ~

R1491 Bot E 12 0402R Resistor 5% 63mW 10k ~

R2000 Bot F 3 0402R Resistor 5% 63mW 220R ~

R2001 Bot F 3
uBGA11_2.15X
1.65

ASIP MIC W/ESD RES
+CAP+ZDI BGA11 ~ ~
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Item Side Grid ref. Type Description and value

R2002 Bot G 3 0402R Resistor 5% 63mW 10R ~

R2003 Bot G 3 0402R Resistor 5% 63mW 10R ~

R2004 Bot G 3 0402R Resistor 5% 63mW 10R ~

R2005 Bot H 3 0402R Resistor 5% 63mW 10R ~

R2006 Bot G 2 uBGA5
ASIP 4XESD **PB-
FREE** BGA5 ~ ~

R2007 Top F 1
uBGA11_1.6X2
.15

ASIP SILIC USB OTG /
ESD BGA11 ~ ~

R2009 Top G 1 0402R Resistor 5% 63mW 100R ~

R2010 Top F 1 0402R Resistor 5% 63mW 220k ~

R2011 Top G 1 0402R Resistor 5% 63mW 120k ~

R2070 Bot G 14 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R2071 Top E 6 0402_NTH5
NTC RES 47K J B=4050
+-3% 0402 47k ~

R2100 Bot F 2
FLIP_CHIP_8_1.
7X1.7

ASIP SINGLE ENDED
MICROPHONE INTERF
BGA8 ~ ~

R2101 Bot E 2 0402R Resistor 5% 63mW 220R ~

R2104 Top E 19 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R2105 Top E 19 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R2106 Bot F 18 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R2107 Bot F 18 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R2200 Top E 6 0402R Resistor 5% 63mW 100k ~

R2201 Top E 6 0402R Resistor 5% 63mW 120k ~

R2202 Top E 6 0402R Resistor 5% 63mW 100R ~

R2205 Top E 7 0402R
CHIPRES 0W06 2M2 J
0402 2M2 ~

R2303 Top F 6 0402R
Chipres 0W06 jumper
0402 0R ~

R2304 Top F 6 0402R Resistor 5% 63mW 33R ~

R2305 Bot C 7 0402R Resistor 5% 63mW 33R ~

R2700 Bot I 6
uBGA8_1.47X1
.47

ASIP SIM INTERFACE
**LOW CAP**BGA8 ~ ~

R3000 Top G 6 0402R Resistor 5% 63mW 10k ~
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Item Side Grid ref. Type Description and value

R4400 Top E 6 0402R Resistor 5% 63mW 470k ~

R4401 Top E 6 0402R Resistor 5% 63mW 100k ~

R4402 Top E 6 0402R Resistor 5% 63mW 470k ~

R4403 Top B 20 0402_NTH5
NTC RES 47K J B=4050
+-3% 0402 47k ~

R4406 Top E 20 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R4407 Bot A 8 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R4408 Bot A 8 0402R Resistor 5% 63mW 10k ~

R4800 Top D 5 0402R Resistor 5% 63mW 10R ~

R4809 Top E 3 0402R Resistor 5% 63mW 1k0 ~

R4810 Top E 6 0402R Resistor 5% 63mW 15R ~

R5100 Top G 5 0402R Resistor 5% 63mW 10k ~

R5200 Bot I 7
uBGA11_1.62X
2.12

ASIP EMIF04-
MMC02F2**PB-FREE** ~ ~

R5204 Bot I 15 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7501 Bot C 9 0402R Resistor 5% 63mW 1k0 ~

R7503 Bot C 11 0402R Resistor 5% 63mW 4k7 ~

R7504 Bot C 11 0402R
CHIPRES 0W06 10K F
0402 10k ~

R7505 Bot C 9 0402R
CHIPRES 0W06 8K2 F
0402 8k2 ~

R7506 Bot G 17 0402R Resistor 5% 63mW 33R ~

R7509 Bot C 8 0402R Resistor 5% 63mW 10k ~

R7512 Bot H 16 0404_RAC10
RES NETWORK 0W04
2DB ATT 0404

436R/
11R6/436
R ~

R7513 Bot B 7 0402R
Chipres 0W06 5R6 J
0402 5R6 ~

R7514 Bot D 9 0402R Resistor 5% 63mW 10k ~

R7516 Bot I 18 0402R Resistor 5% 63mW 1k0 ~

R7518 Bot I 17 0402R Resistor 5% 63mW 470k ~

R7519 Bot B 6 0402R Resistor 5% 63mW 1k0 ~

R7521 Bot D 9 0402R
CHIPRES 0W06 10K F
0402 10k ~

R7523 Bot A 6 0402R
CHIPRES 0W06 9K1 F
100PPM 0402 9k1 ~
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Item Side Grid ref. Type Description and value

R7528 Bot C 8 0402R Resistor 5% 63mW 470k ~

R7534 Bot C 8 0402R Resistor 5% 63mW 470k ~

R7541 Bot F 4 0402R
Chipres 0W06 jumper
0402 0R ~

R7542 Bot F 4 0402R
Chipres 0W06 jumper
0402 0R ~

R7543 Bot F 4 0402R
Chipres 0W06 jumper
0402 0R ~

R7544 Bot F 5 0402R
Chipres 0W06 jumper
0402 0R ~

R7549 Bot F 4 0402R Resistor 5% 63mW 3k3 ~

R7550 Bot F 4 0402R Resistor 5% 63mW 3k3 ~

R7551 Bot C 4 0402R
Chipres 0W06 jumper
0402 0R ~

R7552 Bot F 5 0402R
Chipres 0W06 jumper
0402 0R ~

R7554 Top G 3 0402R Resistor 5% 63mW 100k ~

R7555 Bot B 9 0402R Resistor 5% 63mW 220R ~

R7556 Bot E 6 0402R Resistor 5% 63mW 100R ~

R7558 Bot F 3 0402R Resistor 5% 63mW 220R ~

R7559 Bot G 2 0402_VAR
RES VARISTOR 14/90V
3PF 0402 14/90V ~

R7560 Bot A 17 0402R
Chipres 0W06 jumper
0402 0R ~

S4401 Top E 21
SWITCH_EVQP
7A01K

SM SW TACT SPST 12V
SIDE KEY 2.2N ~ ~

S5200 Bot I 14
SWITCH_SPVN
220100

SM SW DETECTOR SPST-
NO 5V 1MA ~ ~

S5202 Bot A 9
SWITCH_SPVM
110201

SWITCH DETECTOR
SPVM ~ ~

T7501 Bot B 10 TRANS_LDB15
TRANSF BALUN 3800
+-550MHZ 0805 ~ ~

T7502 Bot H 16 TRANS_LDB15
TRANSF BALUN 1800
+-100mhz 2x1.25 ~ ~

T7503 Bot B 7 TRANS_LDB15
TRANSF BALUN 3800
+-550MHZ 0805 ~ ~

V1470 Bot F 14 SC_89
DI SCH DUAL 0.4V 1MA
SOT490 ~ ~

V1471 Bot E 13
DIODE_PMEG3
002

SCH DI PMEG3002 30V
500MA SOD882 ~ ~
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Item Side Grid ref. Type Description and value

V1472 Bot E 12 SC_75A_H0.95
MOSFET N 20V 350MA
SOT416 ~ ~

V2000 Bot C 3
BGA4_1.01X1.
07 ASIP TVS BGA4 ~ ~

V2300 Bot C 7 VMT3_R

TR DTC143ZM N
RB=4K7 RBE=47K
VMT3 ~ ~

V4400 Top B 20 PT202MR0MP

DI PHOTO
PT202MR0MP 620NM
1.25X2 ~ ~

V7501 Bot E 6 SOD323F SCH DI 30V 2A SOD323F ~ ~

V7502 Bot C 15 SOD882 BZX884-AA ~ ~

X1470 Bot E 16
SOCKET_DMD1
0413

CAMERA MOD.SOCKET
2X7POL SPR P1.4 ~ ~

X2001 Bot F 1
SYSCON_MQ20
2_NK_14R3

SM SYSTEM
CONNECTOR 14POL ~ ~

X2060 Top A 9
TRACEABILITY_
PAD

MODULE ID
COMPONENT
2.8X1.8X0.3 ~ ~

X2070 Bot H 14
LYNX_BATT_CO
NN_H7.0

SM BATTERY CONN
3POL SPR 12V 2A ~ ~

X2700 Bot H 6
SIM_CONN_470
191501

SM SIM CONN 6POL
P2.54 H1.5 ~ ~

X4400 Top F 2
SMK_4309_B_B
_16P_V8

SM CONN 16P SPR P1.3
50V PWB/PWB ~ ~

X4401 Top B 19
JST_R_JAVK_G_
1_R3

SM CONN 2X12F P0.4
30V .3A PWB/PWB ~ ~

X5200 Bot H 11

MOLEX_MMC_P
03_3D0545_00
1

CONN SMC RS-MMC
6POL P2.5 ~ ~

X5207 Bot H 4
ANT_CLIP_M3E
14601

SPRING CLIP
M3E14601 NSJ-3
HD925 ~ ~

X5208 Bot B 5
CONTACT_PAD_
2.95X1.95

SM CONN VIBRA
SPACER PAD 2.8X1.8 ~ ~

X5209 Bot B 4
CONTACT_PAD_
2.95X1.95

SM CONN VIBRA
SPACER PAD 2.8X1.8 ~ ~

X5210 Bot A 4
CONTACT_PAD_
2.95X1.95

SM CONN VIBRA
SPACER PAD 2.8X1.8 ~ ~

X5211 Bot A 5
CONTACT_PAD_
2.95X1.95

SM CONN VIBRA
SPACER PAD 2.8X1.8 ~ ~
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Item Side Grid ref. Type Description and value

X5212 Bot C 16
POGO_CNO_51
17_3077H

CONN 2POL SPR
6.6X6.8X2.5 ~ ~

Z2000 Top E 1 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

Z2001 Top E 1 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

Z2003 Top E 1 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

Z4400 Top D 2
uBGA25_2.47X
2.47

ASIP 10-CH ESD EMI
FILTER BGA25 ~ ~

Z4401 Top G 3 FC6_1.65X1.15
ASIP 2-CH MIC EMI/ESD
**PB-FREE** ~ ~

Z4402 Top E 7
uBGA25_2.47X
2.47

ASIP 10-CH ESD EMI
FILTER BGA25 ~ ~

Z4403 Top F 7
uBGA25_2.47X
2.47

ASIP 10-CH ESD EMI
FILTER BGA25 ~ ~

Z7500 Bot F 14
FERRITE_FBMJ1
608

FERRITE BEAD 0R01
28R/100MHZ 0603

28R/
100MHz ~

Z7503 Bot H 18
ANT_SW_M043
B

ANT.SW+3SAW
880-960/1710-1990M
HZ ~ ~

Z7504 Bot I 16
FILTER_SAW_2.
1X1.7_H0.8

SAW FILTER 897.5
+-17.5MHZ 2.0X1.6 897.5MHz ~
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 Component layouts

Component layouts (1YA_02.1f)

Figure 2 Component layout - bottom view (1YA_02.1f)
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Figure 3 Component layout - top view (1YA_02.1f)
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 Phoenix installation steps in brief

Prerequisites
Recommended hardware requirements:

• Computer processor: Pentium 700 MHz or higher

• RAM 256 MB

• Disk space 100-300 MB

Supported operating systems:

• Windows 2000 Service Pack 3 or higher

• Windows XP Service Pack 1 or higher

Context
Phoenix is a service software for reprogramming, testing and tuning phones.

Phoenix installation contains:

• Service software support for all phone models included in the package

• Flash update package files for programming devices

• All needed drivers for:

• PKD-1 (DK2) dongle

• DKU-2 USB cable

Note: Separate installation packages for flash update files and drivers are also available, but it is
not necessary to use them unless there are updates between Phoenix service software releases. If
separate update packages are used, they should be used after Phoenix and data packages have been
installed.

The phone model specific data package includes all changing product specific data:

• Product software binary files

• Files for type label printing

• Validation file for the faultlog repair data reporting system

• All product specific configuration files for Phoenix software components

Note: Phoenix and phone data packages should only be used as complete installation packages.
Uninstallation should be made from the Windows Control Panel.

To use Phoenix, you need to:

Steps
1. Connect a PKD-1 (DK2) dongle to the computer parallel port.

2. Install Phoenix.

3. Install the phone-specific data package.

4. Configure users.

5. Manage connection settings (depends on the tools you are using).

If you use FPS-8: • Update FPS-8 software

• Activate FPS-8
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If you use FPS-10: • Update FPS-10 software

Note: There is no need to activate FPS-10.

• Activate SX-4 smart card, if you need tuning and
testing functions.

Note: When FPS-10 is used only for
product software updates, SX-4 smart
card is not needed.

Results
Phoenix is ready to be used with FPS-8 or FPS-10 flash prommers and other service tools.

 Installing Phoenix

Prerequisites
• Check that a dongle is attached to the parallel port of your computer.

• Download the Phoenix installation package (for example, phoenix_service_sw_2004_39_x_xx.exe) to your
computer (in C:\TEMP, for instance).

• Close all other programs.

• Depending on your operating system, administrator rights may be required to install Phoenix.

• If uninstalling or rebooting is needed at any point, you will be prompted by the InstallShield program.

Context
At some point during the installation procedure, you may get the following message:

Figure 4 Dongle not found

This may be a result of a defective or too old PKD-1 dongle.

Check the COM/parallel ports used. After correcting the problem, you can restart the installation.

For more detailed information, please refer to Phoenix Help files.

Tip: Each feature in Phoenix has its own Help function, which can be activated while running the
program. Press the F1 key or the feature’s Help button to activate a Help file.

Steps
1. To start the installation, run the application file (for example,phoenix_service_sw_2004_39_x_xx.exe).

2. In the Welcome dialogue, click Next.
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3. Read the disclaimer text carefully and click Yes.

Figure 5 Disclaimer text

4. Choose the destination folder.

The default folder C:\ProgramFiles\Nokia\Phoenix is recommended.

5. To continue, click Next.

To choose another location, click Browse (not recommended).

6. Wait for the components to be copied.

The progress of the installation is shown in the Setup Status window.

7. Wait for the drivers to be installed and updated.

The process may take several minutes to complete.

If the operating system does not require rebooting, the PC components are registered right away.

If the operating system requires restarting your computer, the Install Shield Wizard will notifies about it.

Select Yes... to reboot the PC immediately or No... to reboot the PC manually afterwards.

After the reboot, all components are registered.

Note: Phoenix does not work, if the components have not been registered.
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8. To end the installation, click Finish.

Figure 6 InstallShield Wizard Complete

Next actions
After the installation, Phoenix can be used after:

• installing phone model specific data package for Phoenix
• configuring users and connections

FPS-8 and FPS-10 flash prommers can be used after updating their flash update package files.

 Updating Phoenix installation

Context
• If you already have the Phoenix service software installed on your computer, you need to update the

software when new versions are released.

• To update Phoenix, you need to follow the same steps as when installing it for the first time.

• When you are updating, for example, from version a14_2004_16_4_47 to a15_2004_24_7_55, the update
will take place automatically without uninstallation.

• Always use the latest available versions of both Phoenix and the phone-specific data package. Instructions
can be found in the phone model specific Technical Bulletins and phone data package readme.txt files
(shown during installation).

• If you try to update Phoenix with the same version you already have (for example, a15_2004_24_7_55
to a15_2004_24_7_55), you are asked if you want to uninstall the existing version. In this case you can
choose between a total uninstallation or a repair installation in a similar way when choosing to uninstall
the application from the Windows Control Panel.

• If you try to install an older version (for example, downgrade from a15_2004_24_7_55 to
a14_2004_16_4_47), installation will be interrupted.
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Figure 7 Installation interrupted

• Always follow the instructions on the screen.

Steps
1. Download the installation package to your computer hard disk.

2. Close all other programs.

3. Run the application file (for example, phoenix_service_sw_2004_39_x_xx.exe).

Results
A new Phoenix version is installed and driver versions are checked and updated.

 Uninstalling Phoenix

Context
You can uninstall Phoenix service software manually from the Windows Control Panel.

Steps
1. Open the Windows Control Panel, and choose Add/Remove Programs.
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2. To uninstall Phoenix, choose Phoenix Service Software→Change/Remove→Remove .

Figure 8 Remove program

The progress of the uninstallation is shown.

3. If the operating system does not require rebooting, click Finish to complete.

Figure 9 Finish uninstallation
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If the operating system requires rebooting, InstallShield Wizard will notify you. Select Yes... to reboot the
PC immediately and No... to reboot the PC manually afterwards.

 Repairing Phoenix installation

Context
If you experience any problems with the service software or suspect that files have been lost, use the repair
function before completely reinstalling Phoenix.

Note: The original installation package (for example, phoenix_service_sw_a15_2004_24_7_55.exe)
must be found on your PC when you run the repair setup.

Steps
1. Open Windows Control Panel→Add/Remove Programs .

2. Choose Phoenix Service Software→Change/Remove .

3. In the following view, select Repair.

Figure 10 Repair program

Phoenix reinstalls components and registers them.

The procedure is the same as when updating Phoenix.

4. To complete the repair, click Finish.

 Phone data package overview
Each product has its own data package (DP). The product data package contains all product-specific data files
to make the Phoenix service software and tools usable with a certain phone model.

The phone data package contains the following:

• Product software binary files
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• Files for type label printing

• Validation file for the fault log repair data reporting system

• All product-specific configuration files for Phoenix software components

Data files are stored in C:\Program Files\Nokia\Phoenix (default).

 Installing phone data package

Prerequisites
• A phone-specific data package contains all data required for the Phoenix service software and service tools

to be used with a certain phone model.

• Check that a dongle is attached to the parallel port of your computer.

• Install Phoenix service software.

• Download the installation package (for example, XX-XX_dp_EA_v_1_0.exe) to your computer (for example,
in C:\TEMP).

• Close all other programs.

(XX-XX = type designator of the product)

If you already have Phoenix installed on your computer, you will need to update it when a new version is
released.

Note: Often Phoenix and the phone-specific data package come in pairs, meaning that a certain
version of Phoenix can only be used with a certain version of a data package. Always use the latest
available versions of both. Instructions can be found in phone-specific Technical Bulletins and
readme.txt files of data packages.

Steps
1. To start the installation, run the application file (for example, XX-XX_dp_EA_ v_1_0.exe),

Wait for the installation files to be extracted.
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2. Click Next.

3. In the following view you can see the contents of the data package. Read the text carefully. There is
information about the Phoenix version required with this data package.

Figure 11 Data package setup information

4. To continue, click Next.
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5. Choose the destination folder, and click Next to continue.

Figure 12 Data package destination folder

The InstallShield Wizard checks where Phoenix is installed, and the directory is shown.

6. To start copying the files, click Next.

RM-180
Nokia Customer Care Service Software Instructions

Page 3 –14 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



Phone model specific files are installed. Please wait.

7. To complete the installation, click Finish.

Figure 13 InstallShield Wizard Complete

Next actions
Phoenix can be used for flashing phones and printing type labels after:

• Configuring users

• Managing connections

FPS-8 and FPS-10 can be used after updating their flash update package files.

 Uninstalling phone data package

Context
There is no need to uninstall an older version of a data package, unless instructions to do so are given in
the readme.txt file of the data package and bulletins related to the release.

Please read all related documents carefully.

Steps
1. Locate the data package installation file (e.g. XX-XX_dp_EA_v_1_0.exe) from your computer.

2. To start the uninstallation procedure, double-click the data package installation file.
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3. To uninstall the data package, click OK or to interrupt the uninstallation, click Cancel.

Figure 14 Uninstalling phone data package

4. When the data package is uninstalled, click Finish.

Figure 15 Finishing data package uninstallation

Alternative steps
• You can also uninstall the data package manually from

Control Panel→Add/Remove Programs→xx-xx* Phone Data Package . (*= type designator of the
phone).
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 Configuring users in Phoenix

Steps
1. Start Phoenix service software, and log in.

Figure 16 Phoenix login

If the user ID is already configured, select s/he from the User name drop-down list, and click OK.

2. To add a new user, or to edit existing ones, click Maintain.

3. To add a new user, click New.

4. Type in the name and initials of the user, and click OK.

The user is added to the user name list.

5. Select the desired user from the User name drop-down list, and click OK.

Figure 17 New user configured

 Managing connections in Phoenix

Context
With the Manage Connections feature you can edit and delete existing connections or create new ones.

Note: After choosing the desired connection, and connecting the phone to a PC for the first time,
allow the PC to install the USB device drivers first. Please note that this may take some time to
complete.

If there are problems after the driver installation, check that the USB connection is active from
the Windows Control Panel. If the problem persists, contact the local PC support.

Steps
1. Start Phoenix, and log in.

2. Choose File→Manage Connections... .
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3. To add a new connection, click Add.

4. Select Manual mode, and click Next to continue.

If you want to create the connection using the Connection Wizard, connect the tools and a phone to your
PC. The wizard will automatically try to configure the correct connection.

Figure 18 Select mode: Manual

i For an FPS-10 flash prommer with a USB Connection, choose the following connection settings:

• Media: FPS-10 USB

• DEVICE_INDEX: 0

• SERIAL_NUM: See Serial No from the label attached to the bottom of FPS-10

• ACTIVE_MEDIA: USB

ii For an FPS-10 flash prommer with a LAN connection, choose the following connection settings:

• Media: FPS-10 TCP/IP

• NET_SERV_NAME: Click Scan.... Choose your own FPS-10 device based on the correct MAC address.
See Serial No from the label attached to the bottom of your FPS-10.

• PORT_NUM: Use the default value, and click Next.

• PROTOCOL_FAMILY: Use the default value, and click Next.

• SOCKET TYPE: Use the default value, and click Next.

• TX_BUFFER_SIZE: Use the default value, and click Next.

• RX_BUFFER_SIZE: Use the default value, and click Next.

iii For an FPS-8 flash prommer, choose the following connection settings:

• Media: FPS-8

• PORT_NUM: COM Port where FPS-8 is connected

• COMBOX_DEF_MEDIA: FBUS
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iv For a plain USB connection, choose the following connection settings:

Note: First connect the DKU-2 USB cable between the PC USB port and phone.

• Media: USB

5. To complete the configuration, click Finish.

6. Click the connection you want to activate. Use the up/down arrows located on the right hand side to move
it on top of the list, then click Apply.

Figure 19 Connections list

The connection is activated, and it can be used after closing the Manage Connection window.

The connection information is shown at the right hand bottom corner of the screen.

Figure 20 Connection information

7. To use the connection, connect the phone to your PC with correct service tools. Make sure the phone is
switched on, and then choose File→Scan Product .

Results
The product support module information appears in the status bar:

Figure 21 Product support module information (example from RM-1)

 Installing flash support files for FPS-8 and FPS-10

Prerequisites
• Install Phoenix service software.

• Install phone model specific data package for Phoenix.

• If you want to update the flash support files, they are delivered in the same installation package with
Phoenix or newer Phoenix packages beginning from December 2004.

In case you want to update the MCU files, install the latest data package (see Technical Bulletins for
information on the latest one).

Normally, it is enough to install Phoenix and the phone-specific data package because the installation
always includes the latest flash update package files for FPS-8 and FPS-10.

• A separate installation package for flash support files is available. The files can be updated according to
these instructions, if updates appear between Phoenix data package releases.
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Context
If you are not using a separate installation package, you can skip this section and continue with  "Updating
FPS-8 and FPS-10 flash prommer software" (page 3–22) after installing a new phone data package.

Steps
1. To begin the installation, double-click the flash update file (for example,

flash_update_03_183_0014.exe).

Figure 22 Flash update welcome dialog

If the same version of the flash update package already exists, and you want to reinstall it, the previous
package is first uninstalled.

Restart installation again after the uninstallation.

2. If you try to downgrade the existing version to older ones, the setup will be aborted. If there is a need to
downgrade the version, uninstall newer files manually from the Windows Control Panel, and then rerun
the installation.

Figure 23 Flash installation interrupted

If an older version exists on your PC and it needs to be updated, click Next to continue installation.
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3. It is recommended to install the files to the default destination folder C:\Program Files\Nokia\Phoenix.
To continue, click Next.

Figure 24 Flash destination folder

When installing the flash update files for the first time, you may choose another location by selecting
Browse (not recommended).

RM-180
Service Software Instructions Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 3 –21
Copyright © 2006 Nokia. All rights reserved.



4. To complete the installation procedure, click Finish .

Figure 25 Finish flash update

Next actions
FPS-8 and FPS-10 flash prommers must be updated using Phoenix.

 Updating FPS-8 and FPS-10 flash prommer software

Steps
1. Start Phoenix service software, and log in.

2. Choose the correct connection for your flash prommer: File→Manage Connections...

3. Choose Flashing→Prommer maintenance .

4. To update the FPS-8/FPS-10 software, click Update, and select the appropriate file fps8upd.ini (for FPS-8)
or fpsxupd.ini (for FPS-10) from C:\Program Files\Nokia\Phoenix\Flash.

Figure 26 Flash directory window
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Tip: All files can be loaded separately to the prommer used. To do this, click the right mouse button
in the Flash Box Files pane and select the file type(s) to be loaded.

5. Click OK.

Figure 27 Prommer software update finished

6. To close the Prommer Maintenance window, click Close.

Figure 28 Prommer Maintenance window

 Activating FPS-8

Context
Before FPS-8 can be successfully used for phone programming, it must first be activated.

First fill in the FPS-8 activation request sheet in the FPS-8 sales package, and follow the instructions given.

When activation file is received (for example, 00000.in), copy it to the C:\ProgramFiles\Nokia\Phoenix
\BoxActivation directory on your computer (this directory is created when Phoenix is installed).
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Steps
1. Start Phoenix service software.

2. Choose Flashing→Prommer Maintenance .

3. In the Prommer Maintenance window, click Activate.

4. To find the activation file, click Browse.

5. To activate the prommer, select the activation file and click Open.

Figure 29 Box activation

6. To complete the activation, restart FPS-8.

 Deactivating FPS-8

Context
If there is, for example, a need to send the FPS-8 box for repair, it must be deactivated first.

Steps
1. Start Phoenix service software.

2. Choose Flashing→Prommer Maintenance .

3. In the Prommer Maintenance window, click Deactivate.

4. To confirm the deactivation, click Yes.

Figure 30 Deactivation warning
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The box is deactivated.

5. To complete the deactivation, restart FPS-8.
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 Service tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-180, refer to various concepts.

CA-31D USB cable

The CA-31D USB cable is used to connect FPS-10 or FPS-11 to a PC. It is
included in the FPS-10 and FPS-11 sales packages.

CA-35S Power cable

CA-35S is a power cable for connecting, for example, the FPS-10 flash
prommer to the Point-Of-Sales (POS) flash adapter.
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CU-4 Control unit

CU-4 is a general service tool used with a module jig and/or a flash
adapter. It requires an external 12 V power supply.

The unit has the following features:

• software controlled via USB

• EM calibration function

• Forwards FBUS/Flashbus traffic to/from terminal

• Forwards USB traffic to/from terminal

• software controlled BSI values

• regulated VBATT voltage

• 2 x USB2.0 connector (Hub)

• FBUS and USB connections supported

When using CU-4, note the special order of connecting cables and
other service equipment:

Instructions
1 Connect a service tool (jig, flash adapter) to CU-4.

2 Connect CU-4 to your PC with a USB cable.

3 Connect supply voltage (12 V)

4 Connect an FBUS cable (if necessary).

5 Start Phoenix service software.

Note: Phoenix enables CU-4 regulators via USB when it is
started.

Reconnecting the power supply requires a Phoenix restart.
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DKU-2 USB connectivity
cable

USB to system connector cable.

FLS-4S Flash device

FLS-4S is a dongle and flash device incorporated into one package,
developed specifically for POS use.
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FPS-10 Flash prommer

FPS-10 interfaces with:

• PC

• Control unit

• Flash adapter

• Smart card

FPS-10 flash prommer features:

• Flash functionality for BB5 and DCT-4 terminals

• Smart Card reader for SX-2 or SX-4

• USB traffic forwarding

• USB to FBUS/Flashbus conversion

• LAN to FBUS/Flashbus and USB conversion

• Vusb output switchable by PC command

FPS-10 sales package includes:

• FPS-10 prommer

• Power Supply with 5 country specific cords

• USB cable

FS-14 Flash adapter

Flash adapter FS-14 is used for phone testing and flashing.

FS-14 is used with the generic flash adapter base SS-60/62 and control
Unit CU-4 or interface adapter SS-46. When flashing or system testing
the phone, the adapter is attached to replace the phone own battery.

All functions (as well as the calibration voltages, current and the
protections for over voltages, over current and voltage polarity), are
performed by CU-4.

Flash adapter FS-14 main features:

• VBATT supply interface

• USB / FBUS multiplexed interface to the phone

• Supply voltage for light source

JBT-9 Bluetooth test and
interface box (sales
package)

The JBT-9 test box is a generic service device used to perform
Bluetooth bit error rate (BER) testing, and establishing cordless FBUS
connection via Bluetooth. An ACP-8x charger is needed for BER testing
and an AXS-4 cable in case of cordless interface usage testing .

Sales package includes:

• JBT-9 test box

• Installation and warranty information
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MJ-70 Module jig

Module jig MJ-70 is designed for engine testing. It can be used for
flashing and RF, battery and system testing.

Module jig MJ-70 main functions:

• CU-4 interface adapter to phone

• USB / FBUS multiplexed interface to phone

• UI Interface to phone

• STI and XTI test interface

• GSM RF-interface

All functions, except USB / FBUS multiplexing, are performed in CU-4.
For instance, adjusting calibration voltages and current, and all
protections for over current, over voltage and voltage polarity.

PCS-1 Power cable

The PCS-1 power cable (DC) is used with a docking station, a module
jig or a control unit to supply a controlled operating voltage.

PKD-1 SW security device

SW security device is a piece of hardware enabling the use of the
service software when connected to the parallel (LPT) port of the PC.

Without the device, it is not possible to use the service software.

Printer or any such device can be connected to the PC through the
device if needed.

RJ-104 BTHFM rework jig

RJ-104 is a rework jig used when servicing the BTHFM module. It is
used together with rework stencil ST-37.
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RJ-94 Soldering jig

RJ-94 is a soldering jig used for soldering and as a rework jig for the
engine module.

SA-95 RF coupler

SA-95 is an RF coupler for GSM RF testing. It is used together with the
product-specific flash adapter.

The following table shows attenuations from the antenna pads of the
mobile terminal to the SMA connectors of SA-95:

• GSM900 TX Att. (dB) GSM900 RX Att. (dB)

880 MHz 3.2 925 MHz 2.8

897 MHz 3.2 942 MHz 2.0

915 MHz 3.2 960 MHz 2.5

GSM1800 TX Att. (dB) GSM1800 RX Att. (dB)

1710 MHz 5.6 1805 MHz 4.5

1748 MHz 4.9 1843 MHz 4.2

1785 MHz 4.6 1880 MHz 3.9

GSM1900 TX Att. (dB) GSM1900 RX Att. (dB)

1850 MHz 4.3 1930 MHz 5.0

1880 MHz 5.1 1960 MHz 4.6

1910 MHz 5.3 1990 MHz 5.7

SPI-1 Soldering paste
injector
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SPS-1 Soldering Paste
Spreader

SRT-6 Opening tool

SRT-6 is used to open phone covers and B-to-B connectors.

SS-15 Camera removal tool

The camera removal tool SS-15 is used to remove/attach the camera
module from/to the camera socket of the phone PWB.

SS-34 Flex opening tool
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SS-46 Interface adapter

SS-46 acts as an interface adapter between the flash adapter and
FPS-10.

SS-62 Generic flash adapter
base for BB5

• generic base for flash adapters and couplers

• SS-62 equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using galvanic connector or coupler

• multiplexing between USB and FBUS media, controlled by VUSB

SS-68 Antenna cover
opening tool

SS-68 is a tool for removing the antenna cover.

ST-37 BTHFM rework stencil

ST-37 stencil is used with RJ-104 BTHFM rework jig.

SX-4 Smart card

SX-4 is a BB5 security device used to protect critical features in tuning
and testing.

SX-4 is also needed together with FPS-10 when DCT-4 phones are
flashed.
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XCS-1 Service cable

The XCS-1 service cable is used to connect FLS-4S to the POS flash
adapter for supplying a controlled operating voltage and data
connection.

XCS-4 Modular cable

XCS-4 is a shielded (one specially shielded conductor) modular cable
for flashing and service purposes.

XRS-6 RF cable

The RF cable is used to connect, for example, a module repair jig to
the RF measurement equipment.

SMA to N-Connector approximately 610 mm.

Attenuation for:

• GSM850/900: 0.3+-0.1 dB

• GSM1800/1900: 0.5+-0.1 dB
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 Service concepts

Flash concept with FPS-10

Figure 31 Basic flash concept with FPS-10

Note: FPS-8 concept can also be used for flashing.

Item Type Description

1 FS-14 Flash adapter

2 SS-46 Interface adapter

3 CA-35S Power cable

4 XCS-4 Modular cable

5 FPS-10 Flash prommer box

6 Standard USB cable

7 PKD-1 SW security device
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MJ-70 module jig concept

Module jig concept is meant for BB / RF testing + tuning and for flashing purposes.
Figure 32 MJ-70 module jig service concept

Item Type Description

1 MJ-70 Module jig

2 CU-4 Control unit

3 FPS-10 Flash prommer box

4 SX-4 Smart card

5 XCS-4 Modular cable

6 PCS-1 DC power cable

7 Standard USB cable

8 Standard USB cable

9 GPIB control cable

10 XRS-6 RF cable

11 PKD-1 SW security device

12 RF shield box

Note: Item 12 not shown in the picture.
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POS (Point of Sale) flash concept

Figure 33 POS flash concept

Item Type Description

1 DKU-2 USB connectivity cable

2 FLS-4S POS flash device
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Service concept for RF/BB testing and tuning

Figure 34 Service concept for RF/BB testing and tuning

Item Type Description

1 MJ-70 Module jig

2 CU-4 Control unit

3 Standard USB cable

4 PCS-1 DC power cable

5 Standard USB cable + smart card
reader

6 SX-4 Smart card

7 XRF-1 RF cable

8 GPIB control cable

9 PKD-1 SW security device

10 RF shield box

Note: Item 10 not shown in the picture.
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CU-4 flash concept with FPS-10

Figure 35 CU-4 flash concept with FPS-10

Note: FPS-8 concept can also be used for flashing.

Item Type Description

1 FS-14 + SS-62 Flash adapter + generic flash
adapter base for BB5 products

2 CU-4 Control unit

3 XCS-4 Modular cable

4 PCS-1 Power cable

5 FPS-10 Flash prommer box

6 Standard USB cable

7 Standard USB cable

8 PKD-1 SW security device
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RF testing and BB testing/tuning

Figure 36 RF testing and BB testing/tuning

Item Type Description

1 FS-14 + SS-62 Flash adapter + generic flash
adapter base for BB5 products

2 CU-4 Control unit

3 SA-95 RF coupler

4 PCS-1 Power cable

5 Standard USB cable

6 Standard USB cable + smart card
reader

7 SX-4 Smart card

8 GPIB control cable

9 XRF-1 RF cable

10 PKD-1 SW security device

11 RF shield box

Note: Item 11 not shown in the picture.
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LAN connection flash concept

Figure 37 LAN connection flash concept

Item Type Description

1 FS-14 Flash adapter

2 SS-46 Interface adapter

3 CA-35S Power cable

4 XCS-4 Modular cable

5 FPS-10 Flash prommer box

6 LAN cable

7 LAN cable

8 PKD-1 SW security device
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 Disassembly / reassembly instructions

Prerequisites
Required tools for disassembly:

Note: Reassembly takes places in the reverse order.

Note the reassembly-specific instructions in steps 11., 16., 18., 25., 29., and 31..

Steps
1. Always protect the window with a plastic film.

2. Remove the Battery Cover.
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3. Place SRT-6 between the A-Cover and Chassis; release the 4 plastic clips beginning from the bottom
side as shown.

4. Remove the Keymat.

5. Protect the LCD with a plastic film.

6. Protect the inner side window of the A-Cover with a film.
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7. Remove the MMC door from the A-Cover.

8. Insert SRT-6 between the Antenna Cover and the Chassis Assy, and open the Antenna Cover clips.

Note: Additional force may be required to open the clips.

9. Use the tweezers to remove the Power Button.

10. Protect the Camera Rear Bezel Assy with a plastic film before turning the unit.

11. Unscrew the 6 Torx size 6 plus screws in the order shown.

Note: When reassembling, use the reverse order and the torque of 25 Ncm.
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12. Lift the UI Frame from the Chassis. Be careful not to damage the flex foil of the LCD, which is still
connected.

13. Open the flex connector with the SS-34 flex connector opening tool.

Note: Be careful not to damage the surrounding components when using the tool.

After you have opened the flex connector, you can remove the UI Frame.

14. To open each clip of the LCD from the UI Frame, carefully move the UI Frame sideward while pulling
the LCD forward.
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15. Use the dental tool to remove the Earpiece.

16. Use the tweezers to remove the Earpiece Gasket from its compartment.

Note: When reassembling, always use a new gasket.

17. Use SRT-6 to unlatch the BB shield.

18. To remove the BB shield from the UI Frame, hold the frame in your left hand and push down the BB
Shield with SRT-6.

Note: When reassembling, always use a new BB Shield.
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19. To unlock the UI PWB from the UI Frame, carefully pull the PWB upwards.

20. Remove the UI PWB.

21. Remove the Engine Module, and place it onto the RJ-94 jig.

22. Use the tweezers to remove the Vibra Motor.
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23. Use the tweezers to pull out the Microphone.

24. Use the DC plug to remove the DC Jack.

25. Use the tweezers to lift out the IHF speaker.

Note: When reassembling, note the guide pin.

26. Unlock the 5 plastic clips of the Antenna in the places shown.
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27. Carefully separate the Antenna from the UI Frame.

28. Use SRT-6 to lift out the Camera Rear Bezel Assy.

29. Use SRT-6 to completely remove the residues of the Camera Rear Bezel Assy adhesive.

Note: When reassembling, always use new adhesive.

30. To prevent mechanical stress to the PWB, place the Engine Module onto RJ-94, and use SS-15 to remove
the Camera module.

31. Attention: The following steps are for reassembly only!
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• Use the assembly side of SS-15 to fit the Camera module back into its compartment.

• When reassembling, note the correct position of the Camera module.
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 Baseband troubleshooting

Context
This section is intended to be a guide for localising and repairing electrical faults. The fault repairing is divided
into troubleshooting paths. The following main troubleshooting tree describes the different baseband
troubleshooting paths to be followed in fault situations.
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Troubleshooting flow

Figure 38 Main troubleshooting tree
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 Dead or jammed device troubleshooting

Troubleshooting flow
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 General power checking troubleshooting

Troubleshooting flow
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 Clocking troubleshooting

Troubleshooting flow
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 Application processor troubleshooting

Troubleshooting flow

RM-180
BB Troubleshooting and Tuning Guide Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 6 –11
Copyright © 2006 Nokia. All rights reserved.



Figure 39 SysCLK from C7528 & C7531
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Figure 40 SleepCLK from R7558
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 Charging troubleshooting

Troubleshooting flow
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 Battery current measuring fault troubleshooting

Troubleshooting flow
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 Flash programming fault troubleshooting

Troubleshooting flow
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Figure 41 Flashing pic 1. Take single trig measurement for the rise of the BSI signal.

Figure 42 Flashing pic 2. Take single trig measurement for the rise of the BSI signal.
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 CMT SDRAM memory troubleshooting

Troubleshooting flow
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Figure 43 CMT SDRAM CLK from pin J2806
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 CMT NOR flash fault troubleshooting

Troubleshooting flow

RM-180
BB Troubleshooting and Tuning Guide Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 6 –21
Copyright © 2006 Nokia. All rights reserved.



Figure 44 NOR CLK from J2813
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 Application processor memory troubleshooting

Troubleshooting flow
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Take single trig measurement on the falling edge of the CE signal (=J5001).
Figure 45 COMBO NAND in boot pic 1.
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 Power key troubleshooting

Troubleshooting flow
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 USB interface troubleshooting

Troubleshooting flow
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Figure 46 USB 1: D-TXD (POP-PORT pin6) and D+RXD (POP-PORT pin7) voltage levels when USB connected.
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Figure 47 USB 2: Take single triggered measurement on the rising edge of the Helen usb0_txen (J4813) line.
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 SIM card troubleshooting

Troubleshooting flow
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SIM CLK frequency = 3.2MHz (Take single triggered measurement in boot on the VSIM1 line).
Figure 48 SIM interface signals
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 MMC troubleshooting

Troubleshooting flow

RM-180
BB Troubleshooting and Tuning Guide Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 6 –31
Copyright © 2006 Nokia. All rights reserved.



Take singe trig measurement on the rising edge of the DAT signal.
Figure 49 MMC card initialization
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Take single trig measurement on the rising edge of the DAT signal.
Figure 50 Data transfer

 Keyboard troubleshooting

Context
There are two possible failure modes in the keyboard module:

• One or more keys can be stuck, so that the key does not react when a keydome is pressed. This kind of
failure is caused by mechanical reasons (dirt, corrosion).

• Malfunction of several keys at the same time; this happens when one or more rows or columns are faulty
(shortcut or open connection). For a more detailed description of the keyboard and keymatrix, see
section Keyboard in System Module.

If the failure mode is not clear, start with the Keyboard Test in Phoenix.
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Troubleshooting flow

RM-180
Nokia Customer Care BB Troubleshooting and Tuning Guide

Page 6 –34 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



 Slider switch troubleshooting

Troubleshooting flow
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 FM radio troubleshooting

Troubleshooting flow
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 Certificate restoring for BB5.0 products

Context
This procedure is performed when the device certificate is corrupted for some reason.

All tunings (RF & Baseband, UI) must be done after performing the certificate restoring procedure.

The procedure for certificate restoring is the following:

• Flash the phone with the latest available software using FPS-8 or FPS-10.

Note: USB flashing does not work for a dead BB5.0 phone.

• Create a request file.

• Send the file to Nokia by e-mail. Use the following addresses depending on your location:

• APAC: sydney.service@nokia.com

• CHINA: repair.ams@nokia.com

• E&A: salo.repair@nokia.com

• AMERICAS: fls1.usa@nokia.com

• When you receive a reply from Nokia, carry out certificate restoring.

• Tune the phone completely.

Note: SX-4 smart card is needed.

• If the phone resets after certificate restoring, reflash the phone again.

Required equipment and setup:

• Phoenix service software v 2004.39.7.70 or newer.

• The latest phone model specific Phoenix data package.

• PKD-1 dongle

• SX-4 smart card (Enables BB5.0 testing and tuning features)

• External smart card reader

Note: The smart card reader is only needed when FPS-8 is used. FPS-10 has an integrated smart card
reader.

• Activated FPS-8 flash prommer OR FPS-10 flash prommer

• Flash update package 03.18.004 or newer for FPS-8 or FPS-10 flash prommers

• CU-4 control unit

• USB cable from PC USB Port to CU-4 control unit

• Phone model specific adapter for CU-4 control unit

• PCS-1 cable to power CU-4 from external power supply

• XCS-4 modular cable between flash prommer and CU-4

Note: CU-4 must be supplied with +12 V from an external power supply in all steps of certificate
restoring.

Steps
1. Program the phone software.

i Start Phoenix and login. Make sure the connection has been managed correctly for FPS-8 or FPS-10.

ii Update the phone MCU software to the latest available version.

If the new flash is empty and the phone cannot communicate with Phoenix, reflash the phone.
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iii Choose the product manually from File→Open Product , and click OK.

Wait for the phone type designator (e.g. “RM-1” ) to be displayed in the status bar.

iv Go to Flashing→SW Update  and wait until Phoenix reads the product data as shown in the following
picture.

Product is automatically set according to the phone support module which was opened manually,
but the flash files cannot be found because the correct data cannot be read from the phone
automatically.

Code must be chosen manually, it determines the correct flash files to be used. Please choose the
correct product code (can be seen in the phone type label) from the dropdown list.

Flash Type must be set to Phone as Manufactured.

v To continue, click Start.

Progress bars and messages on the screen show actions during phone programming, please wait.
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Programming is completed when Flashing Completed message is displayed.

The product type designator and MCU SW version are displayed in the status bar.

vi Close the SW Update window and then choose File→Close Product .

2. Create a Request file.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i To connect the phone with Phoenix, choose File→Scan Product .

ii Choose Tools→Certificate Restore .

iii To choose a location for the request file, click Browse.
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iv Name the file so that you can easily identify it, and click Open.

The name of the file and its location are shown.

v To create the Request file, click Start.

vi When the file for certificate restore has been created, send it to Nokia as an e-mail attachment.

3. Restore certificate.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i Save the reply file sent by Nokia to your computer.

ii Start Phoenix service software.

iii Choose File→Scan Product .
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iv From the Tools menu, choose Certificate Restore and select Process a response file in the Action
pane.

v To choose the location where response file is saved, click Browse.

vi Click Open.

The name of the file and the path where it is located are shown.

vii To write the file to phone, click Start.

Next actions
After a successful rewrite, you must retune the phone completely by using Phoenix tuning functions.

Important: Perform all tunings: RF, BB, and UI.
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 Display module troubleshooting

General instructions for display troubleshooting

Context
• The display is in a normal mode when the phone is in active use.

• Display is in a partial idle mode when the phone is in the screen saver mode.

• The operating modes of the display can be controlled with the help of Phoenix.

Table 8 Display module troubleshooting cases

Display blank There is no image on the display. The display looks
the same when the phone is on as it does when the
phone is off. The backlight can be on in some cases.

Image on the display not correct Image on the display can be corrupted or a part of
the image can be missing. If a part of the image is
missing, change the display module. If the image is
otherwise corrupted, follow the appropriate
troubleshooting diagram.

Backlight dim or not working at all Backlight LED components are inside the display
module. Backlight failure can also be in the
connector or in the backlight power source in the
main engine of the phone.

This means that in case the display is working
(image OK), the backlight is faulty.

Visual defects (pixel) Pixel defects can be checked by controlling the
display with Phoenix. Use both colours, black and
white, on a full screen.

The display may have some random pixel defects
that are acceptable for this type of display. The
criteria when pixel defects are regarded as a display
failure, resulting in a replacement of the display, are
presented the following table.

Table 9 Pixel defects

Item White dot defect Black dot
defect

Total

1 Defect
counts

R G B White
Dot
Total

1 1

1 1 1 1

2 Combine
d defect
counts

Not allowed.

Two single dot defects that are within 5 mm of each other should
be interpreted as combined dot defect.
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Steps
1. Verify with a working display that the fault is not on the display module itself.

The display module cannot be repaired.

2. Check that the cellular engine is working normally.

i To check the functionality, connect the phone to a docking station.

ii StartPhoenix service software.

iii Read the phone information to check that also the application engine is functioning normally (you
should be able to read the APE ID).

3. Proceed to the display troubleshooting flowcharts.

Use the Display Test tool in Phoenix to find the detailed fault mode.
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Display fault troubleshooting

Troubleshooting flow
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Display and keyboard backlight troubleshooting

Context
The device has one LED driver that provides current for both display and keyboard backlights.

Keyboard backlights are turned ON only in dark conditions. This is controlled by the Ambient Light Sensor
(ALS). Also the brightness of the display is adjusted by the ambient light sensor.

You can enable/disable ALS with the help of Phoenix service software.

Display brightness can be adjusted manually, if ALS is disabled. If the ambient light sensor is enabled, it
adjusts the display brightness automatically.

Troubleshooting flow
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ALS troubleshooting

Context
• If a phototransistor is broken, replace it with a typical phototransistor.

• After replacing the phototransistor or if calibration values are lost for some other reason, ALS re-tuning is
required.

• Before starting the ALS calibration procedure, perform the 'Pull-up resistor calibration' in dark lighting
conditions, and write the measured 'correction' value to the phone. After this ALS calibration procedure
is performed, and the default co-efficient value '1' is written to the phone.

• Make sure that you have completed Display and keypad backlight troubleshooting first before
starting ALS troubleshooting.

Here are some hints for ALS troubleshooting; the following troubleshooting diagram refers to these:

• Phoenix LED control tool also shows you luminance. The correct luminance in darkness is <20 lx, and in
office environment 100-2000 lx. The luminance value depends strongly on the light source and the angle
of the phone, so these values are only a rough guideline.

• LED driver control voltage measurement points can be found from the LED driver troubleshooting
section. When backlight brightness is set to 100%, both GENOUT signals are low, and enable PWM is 100%.

• Phoenix has an ambient light sensor calibration tool for changing calibration values. The pull-up resistor
calibration is done first. See the following procedure.

Steps
1. Cover the light guide (upper part of the A-Cover).

2. Start Phoenix.

3. Choose File→Scan Product.
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4. Choose Tuning→Ambient Light Sensor Calibration.

Figure 51 Ambient Light Sensor Calibration window

5. In the Pull Up Resistor Calibration pane, click Start, and Write.

6. In the Ambient Light Sensor Calibration pane, check the Use default values only check box, and click
Write.

7. To end the calibration, click Close.
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Troubleshooting flow
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LED driver troubleshooting

Troubleshooting flow
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 Bluetooth troubleshooting

Introduction to Bluetooth troubleshooting
There are two main Bluetooth problems that can occur:

Problem Description

Detachment of the BT antenna. This would most likely happen if the device has
been dropped repeatedly to the ground. It could
cause the BT antenna to become loose or partially
detached from the PWB. (see the following section
for details on BT antenna HW and mechanics)

Malfunction in the BT ASIC, BB ASICs or Phone’s BT
SMD components.

This is unpredictable and could have many causes
i.e. SW or HW related.

The main issue is to find out if the problem is related to the BT antenna or related to the BT system or the
phone’s BB and then replace/fix the faulty component.

Location of the BT antenna
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Bluetooth test points

Bluetooth settings for Phoenix

Steps
1. Start Phoenix service software.

2. From the File menu, choose Open Product, and then choose the correct type designator from the
Product list.

3. Place the phone to a flash adapter in the local mode.

4. Choose Testing→Bluetooth LOCALS .

5. Locate JBT-9’s serial number (12 digits) found in the type label on the back of JBT-9.

In addition to JBT-9, also SB-6, JBT-3 and JBT-6 Bluetooth test boxes can be used.
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6. In the Bluetooth LOCALS window, write the 12-digit serial number on the
Counterpart BT Device Address line.

This needs to be done only once provided that JBT-9 is not changed.

7. Place the JBT-9 box near (within 10 cm) the BT antenna and click Run BER Test.

Results
Bit Error Rate test result is displayed in the Bit Error Rate (BER) Tests pane in the Bluetooth LOCALS window.

Figure 52 BER test result

Bluetooth self tests in Phoenix

Steps
1. Start Phoenix service software.

2. ChooseFile→Scan Product.

3. Place the phone to a flash adapter.

4. From the Mode drop-down menu, set mode to Local.

5. Choose Testing→Self Tests.

6. In the Self Tests window check the following Bluetooth related tests:

• ST_LPRF_IF_TEST

• ST_LPRF_AUDIO_LINES_TEST

• ST_BT_WAKEUP_TEST
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7. To run the tests, click Start.

Figure 53 Bluetooth self tests in Phoenix
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Bluetooth troubleshooting

Bluetooth troubleshooting
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Bluetooth BER failure troubleshooting

Troubleshooting flow
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BT audio failure troubleshooting

Troubleshooting flow
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 Audio troubleshooting

Audio troubleshooting test instructions
Differential external earpiece and internal earpiece outputs can be measured either with a single-ended or
a differential probe.

When measuring with a single-ended probe each output is measured against the ground.

Internal handsfree output is measured using a current probe, if a special low-pass filter designed for
measuring a digital amplifier is not available. Note also that when using a current probe, the input signal
frequency must be set to 2kHz.

The input signal for each loop test can be either single-ended or differential.

Required equipment
The following equipment is needed for the tests:

• Oscilloscope

• Function generator (sine waveform)

• 'Active speaker' or 'speaker and power amplifier'

• Sound level meter

• Current probe (Internal handsfree DPMA output measurement)

• Phoenix service software

• Battery voltage 3.7V

Test procedure
Audio can be tested using the Phoenix audio routings option. Three different audio loop paths can be
activated:

• External microphone to Internal earpiece

• External microphone to Internal handsfree speaker

• Internal microphone to External earpiece

Each audio loop sets routing from the specified input to the specified output enabling a quick in-out test.
Loop path gains are fixed and they cannot be changed using Phoenix. Correct pins and signals for each test
are presented in the following table.

Phoenix audio loop tests and test results
The results presented in the table apply when no accessory is connected and battery voltage is set to 3.7V.

Earpiece, internal microphone and speaker are in place during measurement. Applying a headset accessory
during measurement causes a significant drop in measured quantities.

The gain values presented in the table apply for a differential output vs. single-ended/differential input.
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Loop test Input
terminal

Output
terminal

Path
gain [dB]

(fixed)

Input
voltage
[mVp-p]

Differential
output
voltage
[mVp-p]

Output
DC level

[V]

Output
current

[mA]

External Mic to
External Earpiece

XMICP and
GND

HSEAR R P,
HSEAR R N
and GND

-2.9 1000 720 1.2 NA

HSEAR P,
HSEAR N
and GND

XMICN and
GND

HSEAR R P,
HSEAR R N
and GND

HSEAR P,
HSEAR N
and GND

External Mic to
Internal Earpiece

XMICP and
GND

EarP and
GND

-4.5 1000 600 1.2 NA

EarN and
GND

XMICN and
GND

EarP and
GND

EarN and
GND

External Mic to
Internal
handsfree

XMICP and
GND

B2102 pads -5 1000 560 0 25mA
(calc.)

XMICN and
GND

B2102 pads

Internal Mic to
External Earpiece

B2100
(OUT/GND)

HSEAR R P,
HSEAR R N
and GND

22.7 100 1360 1.2 NA

HSEAR P,
HSEAR N
and GND

HSEAR R P,
HSEAR R N
and GND

HSEAR P,
HSEAR N
and GND
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Measurement data

Figure 54 Single-ended output waveform of the Ext_in_HP_out measurement when earpiece is connected.

If a special low-pass filter designed for measuring digital amplifiers is unavailable, the measurement must be performed with a
current probe and the input signal frequency must be 2kHz.

Figure 55 Differential output waveform of the Ext_in_IHF_out out loop measurement when speaker is connected.
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Figure 56 Single-ended output waveform of the HP_in_Ext_out loop when microphone is connected.
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Internal earpiece troubleshooting

Troubleshooting flow
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Internal microphone troubleshooting

Troubleshooting flow
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IHF troubleshooting

Troubleshooting flow
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External microphone troubleshooting

Troubleshooting flow
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External earpiece troubleshooting

Troubleshooting flow
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Vibra troubleshooting

Troubleshooting flow
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 Baseband manual tuning guide

Energy management calibration

Prerequisites
Energy Management (EM) calibration is performed to calibrate the setting (gain and offset) of AD converters
in several channels (that is, battery voltage, BSI, battery current) to get an accurate AD conversion result.

Hardware setup:

• An external power supply is needed.

• Supply 12V DC from an external power supply to CU-4 to power up the phone.

• The phone must be connected to a CU-4 control unit with a product-specific flash adapter.

Steps
1. Place the phone to the docking station adapter (CU-4 is connected to the adapter).

2. Start Phoenix service software.

3. Choose File→ Scan Product.

4. Choose Tuning→Energy Management Calibration.

5. To show the current values in the phone memory, click Read, and check that communication between
the phone and CU-4 works.

6. Check that the CU-4 used check box is checked.

7. Select the item(s) to be calibrated.

Note: ADC calibration has to be performed before other item(s). However, if all calibrations are
selected at the same time, there is no need to perform the ADC calibration first.

8. Click Calibrate.

The calibration of the selected item(s) is carried out automatically.

The candidates for the new calibration values are shown in the Calculated values column. If the new
calibration values seem to be acceptable (please refer to the following "Calibration value limits" table),
click Write to store the new calibration values to the phone permanent memory.

Table 10 Calibration value limits

Parameter Min. Max.

ADC Offset -20 20

ADC Gain 12000 14000

BSI Gain 1100 1300

VBAT Offset 2400 2650

VBAT Gain 19000 23000

VCHAR Gain N/A N/A

IBAT (ICal) Gain 7750 12250

9. Click Read, and confirm that the new calibration values are stored in the phone memory correctly. If the
values are not stored to the phone memory, click Write and/or repeat the procedure again.

10. To end the procedure, close the Energy Management Calibration window.
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 Introduction to RF troubleshooting
All measurements should be done using:

• spectrum analyser with a high-frequency high-impedance passive probe (LO-/reference frequencies and
RF power levels)

• oscilloscope with a 10:1 probe (DC-voltages and low frequency signals)

Caution: All measurements with an RF coupler should be performed in RF shielded environment
because nearby base stations can disturb sensitive receiver measurements. If there is no possibility
to use RF shielded environment, it should be checked that there are no transmissions on the same
frequencies as used in the tests.

The RF section of the phone is build around two RF ASICS: Rx ASIC and Tx ASIC. There is also one GSM PA (Power
Amplifier) on board.

Most RF semiconductors are static discharge sensitive. ESD protection must be taken care of during repair
(ground straps and ESD soldering irons). The RF ASICs, PA and SMPS are moisture sensitive, so parts must be
pre-baked prior to soldering.

In addition to key components, there are lot of discrete components (resistors, inductors and capacitors)
which troubleshooting is done mainly by checking if the soldering of the component is done properly.

A capacitor can be checked for shorts and resistors for value by means of an ohmmeter, but be aware, in-
circuit measurements should be evaluated carefully.

Keep in mind that all measured voltages or RF levels in the service manual are rough figures. Especially RF
levels vary because of different measuring equipment or different grounding of the probe used. All spectrum
analyser measurements in this manual are made with a Fluke PM9639/011 10:1 (500 ohm) probe. It is
recommended that a similar kind of probe is used for all troubleshooting measurements.

When using an RF probe, use a pair of metallic tweezers to connect the probe ground to the PWB ground as
close to the measurement point as possible. If measurements are performed in a product specific module
jig, then “GND” pads should be used for the probe ground.

For additional RF troubleshooting instructions, see Appendix A. These instructions include descriptions/
instructions for RF self-tests as well as troubleshooting instructions for various fault cases.

 RF key component placement
The RF section of the phone is build around two RF ASICs: Rx ASIC N7500 and Tx ASIC N7501.

There is one PA (Power Amplifier) on the board for GSM (N7502).
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Figure 57 RF key component placement
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 Troubleshooting test point locations

Test points for spectrum analyzer

Figure 58 Test point locations for spectrum analyzer
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Test points for oscilloscope

Figure 59 Test points for oscilloscope - bottom
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Figure 60 Test points for oscilloscope - top

 Receiver troubleshooting

Introduction to Rx troubleshooting
Rx can be tested by making a phone call or in the local mode. For the local mode testing, use Phoenix service
software.

The main Rx troubleshooting measurement is RSSI measurement. This test measures the signal strength of
the received signal. I and Q branches can be measured separately. For GSM RSSI measurement, see GSM Rx
chain activation for manual measurements / GSM RSSI measurement (page 7–10).

In GSM, the input signal can be either a real GSM signal or a CW signal that is 67.771 kHz above the carrier
frequency.
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For service tool usage instructions, refer to section Service Tools and Service Concepts.

GSM Rx chain activation for manual measurements / GSM RSSI measurement

Context
RSSI signal measurement is the main Rx troubleshooting measurement. The test measures the strength of
the received signal.

I and Q branches can be measured separately. In GSM, the input signal can be either real GSM signal or a CW
(Continuous Wave) signal that is 67.771 kHz above the carrier frequency.

Steps
1. Start Phoenix service software.

2. Choose Testing→GSM→RSSI Reading .

3. Set the RF signal generator for channel frequency +67.771 kHz CW mode with –80 dBm signal.

Alternatively set the cellular tester downlink channel to the appropriate channel. Make sure that the tester
is set to continuous mode, not to burst mode.

4. In the RSSI Reading window, select the appropriate band and channel.

Figure 61 RSSI Reading window

5. To start the measurement, activate GSM Rx chain, click Start.

Results
RSSI reading values of the selected band and channel are displayed. The RSSI level must be the same value
which is set at the signal generator (-80 dBm).

 Transmitter troubleshooting

General instructions for Tx troubleshooting

Context
• Tx troubleshooting requires Tx operation.

• Do not transmit on frequencies that are in use.

• Transmitter can be controlled in the local mode for diagnostic purposes.
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• The most useful Phoenix tool for GSM transmitter testing is RF Controls.

• Tx IQ tuning and Tx power tuning can be also used in some cases.

• Remember that retuning is not a repair procedure.

The first set of steps instructs how to assemble the test setup. This setup is general for all Tx troubleshooting
tasks.

Alternative steps provide specific troubleshooting instructions for Phoenix service software.

Caution: Never activate the GSM transmitter without a proper antenna load. There should be always
50 ohm load connected to the RF connector (antenna, RF-measurement equipment or at least 2
watts dummy load), otherwise the GSM PA may be damaged.

Steps
1. Connect a test jig to a computer with a DAU-9S cable or to a FPS-8 flash prommer with a modular cable.

Make sure that you have a PKD-1 dongle connected to the computer parallel port.

2. Connect a DC power supply to the module jig.

Note: When repairing or tuning a transmitter, use an external DC supply with at least 3 A current
capability.

Set the DC supply voltage to 3.9 V and set the jumper connector on the test jig's reg.pass switch to
“ON” position.

3. Connect an RF cable between the RF connector of the module test jig and measurement equipment or
alternatively use a 50 ohms (at least 2 W) dummy load in the module test jig RF connector, otherwise the
GSM PA may be damaged.

Note: There are two antenna connectors in the module jig:

• one for GSM

• one for Bluetooth

Make sure that all connections are made to the correct RF connector.

Normally a spectrum analyser is used as measurement equipment.

Note: The maximum input power of a spectrum analyser is +30 dBm.

To prevent any damage, it is recommended to use 10 dB attenuator on the spectrum analyzer input.

4. Set Tx on.

i Place the phone module to the test jig and start Phoenix service software.

ii Initialize connection to the phone. (With FPS-8 use FBUS driver when using DAU-9S and COMBOX driver).

iii Choose File→Open Product→xx-x* (* = type designator of the phone).

iv From the toolbar, set Operating mode to Local.

Alternative steps
• (GSM850)/EGSM900/GSM1800/GSM1900 troubleshooting

i Choose Testing→GSM→RF Controls .

ii In the RF Controls window:

• Select Band.

• Set Active unit to Tx (Default = Rx).

• Set Operation mode to Burst (Default = Burst).

• Set Edge to Off (Default).

• Set Tx Data Type to All 1 (Default = All 1).
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• Set Tx PA Mode to Free (Default).

• Set Tx Power Level in the following way:.

• (GSM850 *if applicable: 37)

• GSM900: 5 (Default = 19)

• GSM1800: 0 (Default = 15)

• GSM1900: 0 (Default = 15)

• Set power level to 5 (Default = 19) on GSM850/GSM900 or to 0 (Default = 15) on GSM1800/GSM1900.

Figure 62 RF Controls window

Checking antenna functionality
The main antenna has one main antenna element: GSM.

In the GSM antenna, there is one Feed and two GND contacts.

The contacts of the GSM antenna are separated in the (RDC = 0 ohm) short-circuit.
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Figure 63 Feed and GND spots of the main antenna

The antenna is functioning normally when the contacts function (RDC = 0 ohm) and the antenna is visually
intact.

BT antenna
BT antenna has one Feed and two GND contacts. The antenna is functioning normally when the contacts
function (RDC = 0 ohm) and the antenna is visually intact.

Figure 64 BT antenna
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Antenna troubleshooting

Troubleshooting flow

 RF tunings

Introduction to RF tunings
Phone RF is tuned in production. There is no reason to do the re-calibration unless:

• one or more of the RF components is changed

• flash memory chip is changed or otherwise corrupted.

Caution:  RF calibration is always performed with the help of a product-specific module jig, never
with an RF coupler. Using an RF coupler in the calibration phase results in a complete mistuning of
the RF side.
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Important: After RF component changes, always use autotuning. Manual tunings are only required
in rare cases.

Cable and adapter losses
RF cables and adapters have some losses. They have to be taken in account when the phone is tuned. As all
the RF losses are frequency dependent, the user have to be very careful and understand the measurement
setup. For more detailed information, see section Service Tools and Service Concepts.

Cable and adapter losses
RF cables and adapters have some losses. They have to be taken in account when the phone is tuned. As all
the RF losses are frequency dependent, the user have to be very careful and understand the measurement
setup. In the following table there are RF attenuations of the module jig:

Band Attenuation

GSM850/GSM900 0.2 dB

GSM1800 0.3 dB

GSM1900 0.3 dB

RF autotuning

Prerequisites
For information on the recommended test set-up, refer to the corresponding information on the Partner
Website or Nokia Online.

Before you can use autotuning, the GPIB driver from the GPIB card vendor must be installed and running.

The autotune .xml file must be in a correct place: C:\Program Files\Nokia\Phoenix\products\xx-xx*
\rfconf_xx-x*.xml (*= indicates the type designator of the phone.)

Context
RF autotuning is performed with the aid of a digital radio communication tester (CMU200). Autotuning covers
all RF tunings that are needed to perform after RF component repairs.

Note: Do not perform RF autotuning without a proper reason. RF tuning may only be performed
after component repairs or if the RF tuning information is lost.

Steps
1. Connect the communication tester to the GPIB bus.

2. Start Phoenix service software.

3. Choose Tools→Options→GPIB Card .

4. From the Card Type drop-down menu, choose the GPIB card used, and click Start.

The name of the communication tester appears in the Listeners pane.
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5. To specify the cable loss from module jig to the communication tester, choose Set Loss from the
Tuning menu.

6. In the Set Loss window, click the Jig tab, and select the right jig for the phone.
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7. Click the Cable tab and add the extra cable attenuation.

8. To start autotuning, choose Auto-Tune from the Tuning menu.

9. In the Auto-Tune window, click Options.

10. In the Auto-Tune options window, see that the Enable showing of message boxes check box is
checked, and click OK.

Results
Autotuning completed successfully! message appears.
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RF manual tuning guide

Required manual tunings after component changes
Important: After RF component changes, always use autotuning. Manual tunings are only required
in rare cases.

If, however, manual tuning is used, only relevant tunings should be performed. Refer to the following table:

Changed component Perform following tunings

Tx RF ASIC RF Channel Filter Calibration, Tx IQ Tuning, Tx Power
Level Tuning, Temperature Sensor Calibration

RX RF ASIC RF Channel Filter Calibration, Rx Calibration, Rx Band
Filter Response Compensation, Rx AM Suppression

Any component in the GSM TX RF chain before the
PA

Tx IQ Tuning, Tx Power Level Tuning

Any component in the GSM TX RF chain after the PA
or PA

Tx Power Level Tuning

Any component in the GSM RX chain Rx Calibration, RX Band Filter Response
Compensation, RX AM Suppression

VCTCXO Rx Calibration

System mode independent manual tunings

RF channel filter calibration

Context
Rx channel filter calibration tunes the internal low pass filters of Rx and Tx ASICs, which limit the bandwidth
of BB IQ signals.

Table 11 RF channel filter calibration tuning limits

Min Typ Max

Tx filter 0 5 31

Rx filter 0 11 31
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Steps
1. From the System mode drop-down menu, set mode to Local.

2. Choose Tuning→RF Channel Filter Calibration .

3. Click Tune.

4. To save the values to the PMM (Phone Permanent Memory) area, click Write.

5. To close the Rf Channel Filter Calibration window, click Close.

Results

Figure 65 RF channel filter calibration typical values

PA (power amplifier) detection

Context
The PA detection procedure detects which PA manufacturer is used for phone PAs.

If a PA is changed or if the permanent memory (PMM) data is corrupted, PA detection has to be performed
before Tx tunings.

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→PA Detection .

3. Click Tune.

4. Check that the detected PA manufacturers are corresponding to the actual chips on the board.

5. To end the procedure, click Close.

Temperature sensor calibration

Context
There is a temperature sensor integrated into one of the device ASICs. The ASIC provides DC-voltage, which
is temperature dependent.

Temperature sensor calibration is done in room temperature, in which offset caused by the ASIC variation
and AD-converter are nullified.

The module is able to do this calibration by itself, no external equipment is needed.

The temperature of the module and components must be 23 +/-2 degrees.

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→Temperature Sensor Calibration .
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3. Click Tune.

Table 12 Temperature sensor calibration tuning limits

Min Typ Max Unit

-20 -4 20 V

4. To save the calibration values, click Write.

5. To finish the calibration, click Close.

GSM receiver tunings

Rx calibration (GSM)

Context
Rx Calibration is used to find out the real gain values of the GSM Rx AGC system and tuning response of the
AFC system (AFC D/A init value and AFC slope)

Steps
1. Connect the GSM connector of the module jig to a signal generator.

2. Start Phoenix service software.

3. Choose File→Scan Product.

4. From the Operating mode drop-down menu, set mode to Local.

5. Choose Tuning→GSM→Rx Calibration.
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6. Click Start.

7. Connect the signal generator to the phone and set frequency and amplitude as instructed in the Tuning
step 1 of 3 - Rx Calibration with band EGSM900 pop-up window.

Note: The calibration uses a non-modulated CW signal. Increase the signal generator level by cable
attenuation and module jig probe attenuation!

8. To perform the tuning, click OK.
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9. Check that the tuning values are within the limits specified in the following table:

Table 13 RF tuning limits in Rx calibration

Min Typ Max Unit

GSM900

AFC Value -200 -105...62 200

AFC slope 0 122 200

RSSI0 106 107...110 114 dB

GSM1800

RSSI0 104 104...109 114 dB

GSM1900

RSSI0 104 104...109 114 dB

10. When the first values have been written to the phone memory, click Next to change to the next band.

11. To finish the tuning, go through all bands, and click Close.

Results

Rx band filter response compensation (GSM)

Prerequisites
Rx Calibration must be performed before the Rx Band Filter Response Compensation.
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Context
On each GSM Rx band, there is a band rejecting filter in front of an RF ASIC front end. The amplitude ripple
caused by these filters causes ripple to the RSSI measurement and therefore calibration is needed.

The calibration has to be repeated for each GSM band.

Steps
1. Connect the GSM connector of the module jig to a signal generator.

2. Start Phoenix service software.

3. Choose File Scan Product.

4. From the Operating mode drop-down menu, set mode to Local.

5. Select GSM900 band.

6. Choose Tuning→GSM→Rx Band Filter Response Compensation.

7. From the Tuning mode drop-down menu, select Manual.

8. Click Start.
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9. Connect the signal generator to the phone and set frequency and amplitude as instructed in the Tuning
step 1 of 3 - Rx Band Filter Response Compensation for EGSM900 pop-up window.

10. To perform the tuning, click OK.

11. Go through all 9 frequencies.

The following window appears, showing signal levels for the input frequencies:

RM-180
Nokia Customer Care RF Troubleshooting and Tuning Guide

Page 7 –24 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



12. Check that the tuning values are within the limits specified in the following table:

Min Typ Max Unit

GSM900

Ch. 965 /
923.26771
MHz

-10 -1 5 dB

Ch. 975 /
925.26771
MHz

-3 0 5 dB

Ch. 987 /
927.66771
MHz

-3 0 5 dB

Ch. 1009 /
932.06771
MHz

-3 0 5 dB

Ch. 37 /
942.46771
MHz

-3 0 5 dB

Ch. 90 /
953.06771
MHz

-3 0 5 dB

Ch. 114 /
957.86771
MHz

-3 0 5 dB

Ch. 124 /
959.86771
MHz

-3 0 5 dB

Ch. 136 /
962.26771
MHz

-10 -1 5 dB

GSM1800

Ch. 497 /
1802.26771
MHz

-10 -1 5 dB

Ch. 512 /
1805.26771
MHz

-3 0 5 dB

Ch. 535 /
1809.86771
MHz

-3 0 5 dB

Ch. 606 /
1824.06771
MHz

-3 0 5 dB
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Min Typ Max Unit

Ch. 700 /
1842.86771
MHz

-3 0 5 dB

Ch. 791 /
1861.06771
MHz

-3 0 5 dB

Ch. 870 /
1876.86771
MHz

-3 0 5 dB

Ch. 885 /
1879.86771
MHz

-3 0 5 dB

Ch. 908 /
1884.46771
MHz

-10 -1 5 dB

GSM1900

Ch. 496 /
1927.06771
MHz

-10 -1 5 dB

Ch. 512 /
1930.26771
MHz

-3 0 5 dB

Ch. 537 /
1935.26771
MHz

-3 0 5 dB

Ch. 586 /
1945.06771
MHz

-3 0 5 dB

Ch. 661 /
1960.06771
MHz

-3 0 5 dB

Ch. 736 /
1975.06771
MHz

-3 0 5 dB

Ch. 794 /
1986.66771
MHz

-3 0 5 dB

Ch. 810 /
1989.86771
MHz

-3 0 5 dB

Ch. 835 /
1994.86771
MHz

-10 -1 5 dB

13. If the values are within the limits, click Next to continue with the next band.
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14. Go through all bands, and click Close to end the tuning.

Results

Rx AM suppression (GSM)

Context
Rx AM suppression is used to tune the AM suppression capabilities of the GSM receiver.

AM suppression is related to the ability of the receiver to operate when there is a disturbing AM modulated
signal near the received channel signal frequency.

RFIC has a tunable compensation circuit which has an effect on the AM suppression ability.

In Rx AM suppression, a continuous signal accompanied with an AM modulated signal 10 MHz above the
current channel is feed to the antenna. RFIC control word values are iterated until a minimum RSSI signal is
found.

Steps
1. Connect the GSM connector of the module jig to a signal generator.

2. Start Phoenix service software.

3. Choose File→Scan Product.

4. From the drop-down menus, set Operating mode to Local, and select the GSM900 band.

5. Choose Tuning→GSM→Rx AM Suppression.
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6. Click Start.

7. Connect the signal generator to the phone according to the frequency and modulation parameters
displayed in the pop-up window:

8. Click OK.

9. Check that RSSI level value is between the limits presented in the following table.

Table 14 RSSI level values

Band Min Max Unit

GSM900 -115 -90 dB

GSM1800 -115 -85 dB

GSM1900 -115 -100 dB
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10. To proceed to the next band, click Next.

11. Go through all bands.

12. To end the tuning, click Finish and Close.

GSM transmitter tunings

Tx IQ tuning (GSM)

Context
• The Tx path branches to I and Q signals at the RF I/Q modulator. Modulator and analog hardware located

after the modulator cause unequal amplitude and phase disturbance to I and Q signal paths. Tx IQ tuning
balances the I and Q branches.

• Tx IQ tuning must be performed on all GSM bands.

Steps
1. Start Phoenix service software.

2. Choose File→Scan Product.

3. From the Operating mode drop-down menu, set mode to Local.

4. Choose Tuning→GSM→Tx IQ Tuning.

5. From the Band drop-down menu, choose GSM900.

6. In the Tx IQ Tuning window, set mode to Automatic.

7. Click Start.

Wait until the automatic tuning feature has finished and moved the sliders.

Values are written to the phone memory automatically.

Tuning sliders should be close to the center of the scale after the tuning and within the limits specified
in the following table.
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Table 15 Tx IQ tuning limits

Min Typ Max Unit

GSM900

I DC offset / Q DC
offset

-6 -4/4 6 dB

Ampl -1 0 1 dB

Phase 85 90 95 dB

GSM1800/GSM1900

I/Q DC -6 -0.5/0.5 6 dB

Ampl -1 0 1 dB

Phase 95 100 110 dB
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8. When the first values have been written to the phone memory, click Next to continue to the next band.

9. Go through all bands.

10. When all bands have been tuned, click Finish, and Close to end the tuning procedure.

Next actions
If the tuning values are not within the limits specified in the "Tx IQ tuning limits" table, start the procedure
again, and check the Tx IQ quality manually.

Tx power level tuning (GSM)

Context
Because of variations in the integrated circuit process and discrete component values, the actual transmitter
RF gain of each phone is different. Tx power level tuning is used to find out mapping factors called 'power
coefficients’. These adjust the GSM transmitter output power to fulfill the specifications.

In dual or triple band phones, the power level tuning is made for both high and low PA Modes (Power Amplifier
Mode) in the GSM900 band but only for high PA mode in GSM1800/GSM1900 bands

For EDGE transmission, the bias settings of the GSM PA are adjusted in order to improve linearity. This affects
the PA gain and therefore the power levels have to be aligned separately for EDGE transmission.

Tx power level tuning has to be performed on all GSM bands.

Steps
1. Connect the phone to a spectrum analyzer.

2. Start Phoenix service software.

3. From the Operating mode drop-down menu, set mode to Local.

4. Choose Tuning→GSM→Tx Power Level Tuning.
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5. Click Start.

The current coefficients saved in the permanent memory (PM) of the terminal are shown.

6. Set the spectrum analyzer for power level tuning:

Frequency channel frequency (897.4MHz GSM900,
1747.8MHz GSM1800, 1880MHz GSM1900)

Span 200 kHz

Sweep time 3s

Trigger Video triggering: Free run

Resolution BW 3 kHz

Video BW 3 kHz

Reference level offset sum cable attenuation with module jig
attenuation

Reference level 33dBm

A power meter with a peak power detector can be also used. Remember to take the attenuations into
account!
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7. Adjust power levels 5, 15 and 19 to correspond the Target dBm column by pressing + or – keys.

Check that the coefficient values are within the limits specified in the following table.

Min Typ Max

GSM900 EDGE off

PL5 coefficient 0.45 0.626 0.73

PL15 coefficient 0.234

PL19 coefficient 0.12 0.195 0.3

GSM900 EDGE on

PL8 coefficient 0.35 0.419 0.6

PL15 coefficient 0.247

PL19 coefficient 0.12 0.204 0.3

GSM1800 EDGE off

PL0 coefficient 0.45 0.51 0.7

PL11 coefficient 0.219

PL15 coefficient 0.12 0.185 0.3

GSM1800 EDGE on

PL2 coefficient 0.35 0.394 0.6

PL11 coefficient 0.23
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Min Typ Max

PL15 coefficient 0.12 0.194 0.3

GSM1900 EDGE off

PL0 coefficient 0.45 0.482 0.7

PL11 coefficient 0.218

PL15 coefficient 0.12 0.184 0.3

GSM1900 EDGE on

PL2 coefficient 0.35 0.377 0.6

PL11 coefficient 0.23

PL15 coefficient 0.12 0.193 0.3

8. If the values are within the limits, click Next to proceed to the next band, and click Start.

9. Set Edge mode on and start tuning again. Change video averaging to 50.

10. Tune EDGE power levels to the corresponding target power levels.

Only power levels 8, 15 and 19 are tuned in GSM900, and 2, 10 and 15 in GSM1800/1900.

11. When the tuning is completed, close the Tx Power Level Tuning window.
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 Introduction to camera module troubleshooting

Background, tools and terminology
Faults or complaints in camera operation can be roughly categorised into three subgroups:

1 Camera is not functional at all; no image can be taken.

2 Images can be taken but there is nothing recognizable in them.

3 Images can be taken and they are recognizable but for some reason the quality of images is seriously
degraded.

Image quality is very hard to measure quantitatively, and even comparative measurements are difficult
(comparing two images) to do, if the difference is small. Especially if the user is not satisfied with his/her
device's image quality, and tells, for example, that the images are not sharp, it is fairly difficult to accurately
test the device and get an exact figure which would tell whether the device is functioning properly.

Often subjective evaluation has to be used for finding out if a certain property of the camera is acceptable
or not. Some training or experience of a correctly operating reference device may be needed in order to
detect what actually is wrong.

It is easy for the user to take bad images in bad conditions. Therefore the camera operation has to be checked
always in constant conditions (lighting, temperature) or by using a second, known-to-be good device as
reference.

When checking for possible errors in camera functionality, knowing what error is suspected significantly
helps the testing by narrowing down the amount of test cases. The following types of image quality problems
may be expected to appear:

• Dust (black spots)

• Lack of sharpness

• Bit errors

Terms

Dynamic range Camera's ability to capture details in dark and bright areas of the scene
simultaneously.

Exposure time Camera modules use silicon sensor to collect light and for forming an
image. The imaging process roughly corresponds to traditional film
photography, in which exposure time means the time during which the
film is exposed to light coming through optics. Increasing the time will
allow for more light hitting the film and thus results in brighter image. The
operation principle is exactly the same with silicon sensor, but the shutter
functionality is handled electronically i.e. there is no mechanical moving
parts like in film cameras.

Flicker Phenomenon, which is caused by pulsating in scene lighting, typically
appearing as wide horizontal stripes in an image.

Noise Variation of response between pixels with same level of input illumination.

Resolution Usually the amount of pixels in the camera sensor. In some occasions the
term resolution is used for describing the sharpness of the images.

Sensitivity Camera module's sensitivity to light. In equivalent illumination conditions,
a less sensitive camera needs a longer exposure time to gather enough
light in forming a good image. Analogous to ISO speed in photographic
film.
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Sharpness Good quality images are 'sharp' or 'crisp', meaning that image details are
well visible in the picture. However, certain issues, such as non-idealities
in optics, cause image blurring, making objects in picture to appear 'soft'.
Each camera type typically has its own level of performance.

 The effect of image taking conditions on image quality
There are some factors, which may cause poor image quality, if not taken into account by the end user when
shooting images, and thus may result in complaints. The items listed are normal to camera operation and
are not a reason for changing the camera module.

Distance to target
The lens in the module is specified to operate satisfactorily from 64 cm to infinite distance of scene objects.
In practice, the operation is such that close objects may be noticed to get more blurred when distance to
them is shorter than 64 cm. The lack of sharpness is first visible in full resolution images. If observing just
the viewfinder, even very close objects may seem to appear sharp. This is normal; do not change the camera
module.

Figure 66 Blurred image. Target too close.

The amount of light available
In dim conditions camera runs out of sensitivity. The exposure time is long (especially in the night mode)
and the risk of getting shaken (= blurred) images increases. In addition, image noise level grows. The
maximum exposure time in the night mode is ¼ seconds. Therefore, images need to be taken with extreme
care and by supporting the phone when the amount of light reflected from the target is low. Because of the
longer exposure time and larger gain value, noise level increases in low light conditions. Sometimes blurring
may even occur in daytime, if the image is taken very carelessly. See the figure below for an example. This
is normal; do not change the camera module.
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Figure 67 Blurring caused by shaking hands

Movement in bright light
If an image is taken of moving objects or if the device is used in a moving vehicle, object 'skewing' or 'tilting'
may occur. This phenomenon is fundamental to most CMOS camera types, and usually cannot be avoided.
The movement of camera or object sometimes cause blurring indoors or in dim lighting conditions because
of long exposure time. This is normal; do not change the camera module.

Figure 68 Near objects get skewed when taking images from a moving vehicle

Temperature
High temperatures inside the mobile phone cause more noise to appear in images. For example, in +70
degrees (Celsius), the noise level may be very high, and it further grows if the conditions are dim. If the phone
processor has been heavily loaded for a long time before taking an image, the phone might have considerably
higher temperature inside than in the surrounding environment. This is also normal to camera operation;
do not change the camera module.
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Figure 69 Noisy image taken in +70 degrees Celsius

Phone display
If the display contrast is set too dark, the image quality degrades: the images may be very dark depending
on the setting. If the display contrast is set too bright, image contrast appears bad and "faint". This problem
is solved by setting the display contrast correctly. This is normal behaviour; do not change the camera module.

Basic rules of photography (especially shooting against light)
Because of dynamic range limitations, taking images against bright light might cause either saturated image
or the actual target appear too dark. In practice, this means that when taking an image indoors and having,
for example, a window behind the object, the result is usually poor. This is normal behaviour; do not change
the camera module.

Figure 70 Image taken against light

Flicker
In some occasions a bright fluorescent light may cause flicker in the viewfinder and captured image. This
phenomenon may also be a result, if images are taken indoors under the mismatch of 50/60 Hz electricity
network frequency. The electricity frequency used is automatically detected by the camera module. In some
very few countries, both 50 and 60 Hz networks are present and thus probability for the phenomenon
increases. Flickering occurs also under high artificial illumination level. This is normal behaviour; do not
change the camera module.
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Figure 71 Flicker in an image; object illuminated by strong fluorescent light

Bright light outside of image view
Especially the sun can cause clearly visible lens glare phenomenon and poor contrast in images. This happens
because of undesired reflections inside the camera optics. Generally this kind of reflections are common in
all optical systems. This is normal behaviour; do not change the camera module.

Figure 72 A lens reflection effect caused by sunshine
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Examples of good quality images

Figure 73 Good image taken indoors

Figure 74 Good image taken outdoors

 Image quality analysis

Testing for dust in camera module

Symptoms and diagnosis
For detecting dust problems, take an image of a uniform white surface and analyse it in full resolution. A
good quality PC CRT monitor is preferred for analysis (avoid using LCD). Search carefully because finding these
defects is not always easy. Figure "Effects of dust on optical path" is an example of an image having easily
detectable dust problems.

When taking a white image, use uniformly lightened white paper or white wall. Another option is to use
uniform light but in this case make sure that the camera image is not flickering when taking the test image.
In case flickering occurs, try to reduce the illumination level. Use JPEG image format for analysing, and set
the image quality parameter to ‘High Quality’.
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Black spots in an image are caused by dirt particles trapped inside the optical system. Clearly visible and
sharp edged black dots in an image are typically dust particles on the image sensor. These spots are searched
for in the manufacturing phase, but it is possible that the camera body cavity contains a particle, which may
move onto the image sensor active surface, for example, when the phone is dropped. Therefore it is also
possible that the problem will disappear before the phone is brought to service. The camera should be
replaced if the problem is present when the service technician analyses the phone.

If dust particles are lying on the infrared filter surface on either side, they are hard to locate because they
are out of focus, and appear in the image as large, grayish and fading-edge 'blobs'. Sometimes they are
invisible to the eye, and the user probably does not notice them at all. However, it is possible that a larger
particle disturbs the user, causing need for service.

Figure 75 Effects of dust on optical path

If large dust particles get trapped on top of the lens surface in the cavity between the camera window and
the lens, they will cause image blurring and poor contrast. If dust stays on the camera module surface, camera
cussion, camera bezel or window at assembling, dust may sneak into the optical system as the optical zoom
or Auto focus lens moves back and forth. The camera cussion and bezel between the window and the lens
unit or camera module should prevent any particles from getting into the cavity after the manufacturing
phase.

If dust particles are found on the sensor, this is classified as a manufacturing error of the module, and the
camera should be replaced. Any particles inside the cavity between the protection window and the lens have
most probably been trapped there in the assembly phase at a Nokia factory. Unauthorized disassembling of
the product can also be the root of the problem. However, in most cases it should be possible to remove the
particle(s) by using clean compressed air. Never wipe the lens surface before trying compressed air; the
possibility of damaging the lens is substantial. Always check the image sharpness after removing dust.

Testing camera image sharpness

Symptoms and diagnosis
If pictures taken with a device are claimed to be blurry, there are six possible sources for the problem:

1 The protection window is fingerprinted, soiled, dirty, visibly scratched or broken.

2 The photographed object is too close – the camera lens operates with distances from 64 cm to infinity.
This is no cause to replace camera module.

3 User has tried to take pictures in too dark conditions, and images are blurred due to handshake or
movement. This is no cause to replace camera module.

4 There is dirt between the protection window and camera lens.
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5 The protection window is defective. This can be either a manufacturing failure or caused by the user. The
window should be changed.

6 The camera lens is misfocused because of a manufacturing error.

A quantitative analysis of sharpness is very difficult to conduct in any other environment than optics
laboratory. Therefore, subjective analysis should be used.

If no visible defects (items 1-4) are found, a couple of test images should be taken. Generally, a well-
illuminated typical indoor scene can be used as a target. The main considerations are:

• The protection window has to be clean.

• The amount of light (300 – 600 lux (bright office lighting)) is sufficient.

• The scene should contain, for example, small objects for checking sharpness. Their distance should be 1
– 2 meters.

• If possible, compare the image to another image of the same scene, taken with a different device. Note
that the reference device has to be a similar Nokia phone.

Steps
1. Take several images of small objects in the distance of 1-2 metres.

2. Analyse the images on a PC screen at 100% scaling with the reference images.

Pay attention to the computer display settings: at least 65000 colors (16-bit) have to be used. True colour
(24-bit, 16 million colours) or 32-bit (full colour) setting is recommended.

Next actions
If there appears to be a clearly noticeable difference between the reference image and the test images, the
module might have a misfocused lens -> change the module.

Re-check the resolution after changing the camera module.

If the changed module produces the same result, the fault is probably in the camera window. Check the
window by looking carefully through it when replacing the module.

Dirty camera lens protection window
The following series of images demonstrates the effects of fingerprints on the camera protection window.

It should be noted that the effects of any dirt in images can vary much. It may be difficult to judge whether
the window has been dirty or if something else is wrong. Therefore, the cleanness of the protection window
should always be checked and the window should be wiped clean with a suitable cloth.

Figure 76 Image taken with clean protection window Figure 77 Image taken with greasy protection window

Image bit errors
Bit errors are image defects caused by data transmission errors between the camera module and the phone
baseband and/or errors inside the module.
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Usually bit errors can be easily detected in images, and they are best visible in full resolution images. A good
practice is to use a uniform white test target when analysing these errors. The errors are clearly visible,
colourful sharp dots or lines in camera images. See the following figure.

Figure 78 Bit errors caused by JPEG compression

One type of bit error is a lack of bit depth. In this case, the image is almost totally black under normal
conditions, and only senses something in very highly illuminated environments. Typically this is a contact
problem between the camera module and the phone main PWB. You should check the camera assembly and
connector contacts.

If the fault is in the camera module, bit errors are typically visible only when using some specific image
resolution. For example, in case of a viewfinder fault, the error might exist but is not visible in a full size
image.

Note: At the most 5 clusters of black dots or blemish are not considered errors, and no reason to
replace camera module
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 Camera troubleshooting flowcharts

Camera hardware failure message troubleshooting

Troubleshooting flow
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Note: Make sure that the phone has the latest software before continuing.

Camera baseband HW troubleshooting

Troubleshooting flow
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Camera viewfinder troubleshooting

Troubleshooting flow
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Bad camera image quality troubleshooting

Troubleshooting flow
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 Flash LED troubleshooting

Introduction to flash LED troubleshooting
A fault or complaint associated to LED flash operation can be roughly categorized into two subgroups:

1 Flash is not functional at all (no light output at all).

2 Images can be taken and they are recognizable but for some reason the quality of images is degraded.

Examples of quality degradations:

• Brightness is not sufficient.

• Brightness is too much = overexposed.

• Only portions of the image brightness (e.g., left, right, top or bottom) are proper and the rest are not.

The quality of an image is very difficult to measure quantitatively, and even comparative measurements are
difficult (comparing two images), if the difference between reference images is small. If a user is not satisfied
with his/her device's image quality, it is fairly difficult to accurately test the device and get an exact result,
which would tell if the device is working properly.

Often subjective evaluation has to be used for finding out if there is something wrong in the flash. Some
training or experience of a correctly operating reference device may be needed in order to detect possible
faults. It is easy for a user to take low quality images in bad conditions. Therefore, the camera and flash
operation has to be always checked in constant conditions (lighting, temperature) or by using a second,
known-to-be good reference device.

Flash LED and image taking conditions
This section describes some of common factors, which may cause poor image quality if not taken into account
by end users when taking pictures, and may therefore result in complaints. The items described are normal
to the camera and LED flash operation and do not raise a need for servicing the components.

Figure 79 Example of a good quality image taken with the flash LED
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Distance to the target (too close)
There is no feedback in the flash system, which means that the light output is constant in every situation.
This causes the images to overexposure, when shot from close distance. The flash LED is designed to work
optimally between distances of 70 cm – 1.2 m.

This is normal behaviour; do not change the flash module.

Figure 80 overexposed image

Distance to the target (too far away):
The power of the white LED flash is still very modest compared to xenon flash technology. Even with full
power, the maximum distance for an acceptable image quality is roughly 1.2 m. If the distance is greater
than 1.2 m, the images will appear dark and the noise level increases.

This is normal behaviour; do not change the flash module.
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Figure 81 Dark and noisy image

Shaken (= blurred) images
The traditional xenon flash has the advantage of stopping the movement. This is a result of an extremely
short and intense light pulse, which makes it possible for a camera to use very short exposure time. Due to
the weak output of the LED flash, the exposure time has to be actually increased in the viewfinder mode in
total blackness, instead of shortening it. This allows the sensor to integrate longer and collect more light but
this also easily creates blurred images if care is not taken.

In addition to the limitation due to small LED flash light, handshake owing to camcoder type product concept
and shutter button operation exists. These are not errors but a limitation of the product. No need to change
the LED flash module.
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Figure 82 Shaken image

Camera white balance failure and overexposure due to presence of ambient light
Because the spectral output of the flash is known, the white balance and the exposure control of the camera
work in optimal way with the flash in total blackness. This is why some of the pictures may fail (i.e. images
get a bit yellow or reddish, or greenish or bluish, depending on the ambient light characteristics, as well as
overexposed or underexposed).

If the flash works correctly in dark conditions, there is no need to change the flash module.
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Figure 83 Camera white balance failure and overexposure

Colour difference between different modules
There is some variation in the spectrum of the flash, which derives from the manufacturing process of the
white LEDs. Because of this variation, there may be some variation in the colour of the images as well.

This is normal behaviour; do not change the flash module.

Figure 84 Color difference between flash colour limit samples

Flash LED construction
This section describes the mechanical construction of the LED flash module.

RM-180
Nokia Customer Care Camera Module Troubleshooting

Page 8 –22 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



Figure 85 Mechanical construction of the flash LED module

The flash LED module as a component is not a repairable part, meaning that. components or parts in the
module cannot be changed. Only cleaning dust from the lens is allowed using clean compressed air.

The main parts of the module are:

• Housing, which is glued to the PWB

• Lens area (round area on top of the housing with circle patterns)

• LED chip (yellow chip inside the housing), which is soldered to the PWB

• ESD protection diode (black passive component inside the housing), which is soldered to the PWB

• PWB

• Contact pads

• Laser marked serial number

The flash LED is fixed to the phone mechanics with special clips. The contacts to the main PWB are formed
by using spring connectors.

Analysing image quality

Possible faults in image quality
When checking for possible errors in the flash functionality, knowing what error is suspected, significantly
helps the testing by narrowing down the number of possible test cases. The following types of image quality
problems may be expected to appear:

• LED module is not flashing at all

• Image colours are not good

• Flash power is weak

Testing flash module functionality

Context
With the help of this test you can check the flash module's overall functionality.

Always set the flash to FORCED FLASH mode when performing the test. The FORCED FLASH mode enforces the
LED module to flash, even if there is some ambient light present.

Steps
1. Take an image with the flash and monitor at same time whether the LED module flashes.
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Results
If the LED flashes normally, the overall functionality of the module is OK.

Testing image colours with flash

Context
With the help of this test you can check if the image colours are normal when using the flash.

Steps
1. Take an image of a target, which contains something white in total blackness from less than 1 m range.

Results
If the white target appears to be white, the flash is working correctly. However, remember that there is some
variation in the flash colour from module to module.

Testing flash power

Context
With the help of this test you can check if the flash is working with adequate power level.

Steps
1. Take an image with the flash in total blackness (ambient light <1 lux) of a target 80 cm - 1 m away.

Results
If the flash is working normally with adequate power level, the image is correctly exposed between distances
80 cm to 1 m.

Remember that the brightness level in the corners is always less than in the center of the image because of
camera and flash optics.
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Flash LED troubleshooting flowcharts

Bad image quality when using flash LED

Troubleshooting flow

Flash LED indicator mode troubleshooting

Troubleshooting flow
For checking the indicator mode functionality, force the camera to record a video clip and monitor the flash
led at the same time. The flash LED should work with very low brightness constantly during the video
recording.
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Flash LED HW baseband troubleshooting

Troubleshooting flow
If there are problems in the flash LED driver circuit, the testing procedure is complicated, because the driver
circuit output cannot be reliably measured without the load (LED). Load (LED) is always disconnected from
the output when the phone is disassembled.
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 Baseband description

System module block diagram
The device consists of two different main modules: transceiver and UI. The transceiver board consists of
baseband and RF components. The UI board consists of key domes and keypad backlights. Connection
between the UI and the transceiver board is established via a board-to-board spring connector.

Note: In this description, the user interface hardware includes the following components: display,
camera, keyboard, keyboard backlight and ALS.

Figure 86 System level block diagram

Baseband functional description
Digital baseband consists of an ISA (Intelligent Software Architecture) based modem and Symbian based
application sections. The modem functionality is in RAP, and the application processor engine acts as a
platform for Symbian applications. The terms ISA and Symbian are used refer to the software environment
of these devices.

The modem section consists of a RAP ASIC with NOR FLASH and SDRAM memory as the core. RAP supports the
GSM (EDGE class 10, GPRS phase2) cellular protocol. The modem SDRAM memory has 64Mbits of memory and
NOR flash has 64Mbits of memory. RAP operates with the system clock of 38.4 MHz, which comes from the
VCTCXO.
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The application section includes an application processor ASIC with DDR/NAND combo memory as the core.
The ASIC uses a 19.2 MHz clock, which comes from the RAP divided by two from the 38.4 MHz system clock.

Figure 87 Functional block diagram

The application processor processes the application SW and handles the UI SW. It consists of OMAP3.3 and
peripheral subsystems such as camera, display and keyboard driver blocks.
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Figure 88 Application processor high level block diagram

Section Description

Application processor also called an application ASIC because it is
processing application SW and handles the UI SW.
It consists of OMAP3.3 and peripheral subsystems
like camera, display and keyboard driver blocks.

OMAP3.3 consists of ARM926 (MPU subsystem), TMS320C55x
(DSP subsystem), DMA and OMAP3.3s internal
peripherals.

Helen3 (OMAP1710) MPU subsystem based on an ARM926EJ. MPU is able to perform most
of the application operations on the chip.

System DMA component mainly used to help the MPU and DSP perform data
memory transfer-specific tasks, leaving more
available MIPS for both processors.

DSP subsystem based on a TMS320C55x™ DSP core, which is
responsible for intensive data computing tasks like
real-time audio and video handling on application
side, e.g. voice recording.

Internal memory subsystem composed of a single port SRAM.

Secure modules Application processor contains a set of several
components, including ROM, a single port SRAM, and
eFUSE cells. These components enable the system to
support secure applications.

Memory interfaces The memory interfaces define the system memory
access organization of application processor.
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Section Description

USB & modem interface These two modules enable the platform to support
a universal serial link and a dedicated modem
interface, enabling a high data transfer rate
between the modem and the application chip.

System components System components are group of modules
responsible for managing system interactions such
as interrupt, clock control and idle.

Peripheral subsystem The peripheral subsystem defines all the
components used to interface application processor
with specific external devices such as camera,
keyboard, display, etc.

Absolute maximum ratings

Signal Min Nom Max Uni
t Notes

Battery voltage (idle) -0.3 +4.5 V Battery voltage maximum value is
specified during charging is active

Battery voltage (Call) +3.2 +4.3 V Battery voltage maximum value is
specified during charging is active

Charger input voltage -0.3 +20 V

Back-Up supply voltage 0 2.5 2.6 V Maximum capacity of the backup
power supply assumed to be 10 µAh.

Phone modes of operation

Mode Description

NO_SUPPLY (dead) mode means that the main battery is not present or its voltage is too low (below
N2200 master reset threshold) and that the back-up battery voltage is too low.

BACK_UP The main battery is not present or its voltage is too low but back-up battery voltage is
adequate and the 32 kHz oscillator is running (RTC is on).

PWR_OFF In this mode (warm), the main battery is present and its voltage is over N2200 master
reset threshold.

RESET RESET mode is a synonym for start-up sequence. RESET mode uses 32 kHz clock to count
the REST mode delay (typically 16 ms).

SLEEP SLEEP mode is entered only from PWR_ON mode with the aid of SW when the system’s
activity is low. There are in principle three different sleep modes:

• Application processor sleep

• RAP sleep

• Application processor and RAP sleep (deep sleep)

FLASHING FLASHING mode is for SW downloading.
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Voltage limits

Parameter Description Value

VMSTR

Master reset
threshold
(N2200) 2.2V (typ.)

VMSTR+

Threshold
for
charging,
rising
(N2300) 2.1V (typ.)

VMSTR-

Threshold
for
charging,
falling
(N2300) 1.9V (typ.)

VCOFF+

Hardware
cutoff
(rising) 2.9V (typ.)

VCOFF-

Hardware
cutoff
(falling) 2.6V (typ.)

SWCOFF
SW cutoff
limit ~3.2V

The master reset threshold controls the internal reset of N2200 / (N2300). If battery voltage is above VMSTR,
N2300’s charging control logic is alive. Also, RTC is active and supplied from the main battery. Above VMSTR,
N2300 allows the system to be powered on although this may not succeed due to voltage drops during start
up. SW can also consider battery voltage too low for operation and power down the system.

Power key
The system boots up when power key is pressed (adequate battery voltage, VBAT, present).

Power down can be initiated by pressing the power key again (the system is powered down with the aid of
SW). Power on key is connected to N2200 ASIC via PWRONX signal.
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Power distribution

Figure 89 Power distribution diagram

Power supply components:

• N2200

• N2300

• D4800 VCORE SMPS

• BT

• LDO

• camera LDO

• backlight SMPS

All the above are powered by the main battery voltage.
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Battery voltage is also used on the RF side for power amplifiers (GSM PA) and for RF ASICs N7500(Rx) & N7501
(Tx).

Discrete power supplies are used to generate 2.8 V to BT, 1.5 V for the camera IO voltage, 1.3V/1.5V for D4800
and 18V for the backlight LEDs.

The device supports both 1.8V/3 V SIM cards which are powered by N2200 / VSIM1. N2200s VSIM2 is used to
power RS MMC 1.8 V only. USB accessories which needs power from the device are powered by N2300 / VOUT.

Because LED driver in N2300 is not used, the external SMPS is used instead. External LED SMPS is still controlled
by N2300 and powered by battery voltage.

System power-up
After inserting the main battery, regulators started by HW are enabled. SW checks, if there is some reason to
keep the power on. If not, the system is set to power off state by watchdog. Power up can be caused by the
following reasons:

• Power key is pressed

• Charger is connected

• RTC alarm occurs

• MBUS wake-up

After that:

• N2200 activates sleep clock and VANA, VDRAM, VIO and VR1 regulators.

• Voltage appearing at N2200’s RSTX pin is used for enabling N2300 ASIC.

• N2300 enables VCORE regulator and its internal RC-oscillator (600kHz).

• VCTCXO regulator is set ON and RF clock (main system clock) is started to produce.

• N2200 will release PURX ~ 16ms after power up is enabled (the RF clock is then stable enough).

• Synchronizing clock (2.4MHz) for N2300 is started to be produced. After PURX is released and two rising
edges of 2.4MHz synchronous clock have been detected in SMPSClk input N2300 is starting to use that
instead of 600kHz internal RC-oscillator.

• HW start-up procedure has been finalized and the system is up and running. Now it is possible for SW to
switch ON other needed regulators.

Clocking scheme
There are two main clocks in the system: a 38.4 MHz RF clock produced by VCTCXO in the RF section, and a
32.768 kHz sleep clock produced by EM ASIC N2200 with an external crystal.

The RF clock is generated only when VCTCXO is powered on by an N2200 regulator. The regulator itself is
activated by SleepX signals from both RAP and the application processor. When both CPUs are on sleep, the
RF clock is stopped.

The RF clock is used by RAP that then provides (divided) 19.2 MHz SysClk further to the application processor.
Both RAP and the application processor have internal PLLs, which then create clock signals for other peripheral
devices/interfaces like memory card, SIM, CCP, I2C and memories.

32k Sleep Clock is always powered on after startup. Sleep clock is used by RAP and the application processor
for low-power operation.

SMPS Clk is a 2.4 MHz clock line from RAP to EM ASIC N2300 used for switch mode regulator synchronizing in
the active mode. In the deep sleep mode, when VCTCXO is off, this signal is set to '0'-state.

BT Clk is a 38.4 MHz signal from Tx ASIC N7501 to the Bluetooth system.

CLK600 is a 600 kHz signal from N2300 to APE VCORE SMPS. The clock source is an internal RC oscillator in
N2300 (during the power-up sequence) or RAP SMPS Clk divided by 4 after the power-up sequence.
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Figure 90 Clocking scheme

Bluetooth/FM module
The device has a module version of Bluetooth, in which BT and FM radio solutions are combined to a single
BTHFM module. The module includes all external components except the antenna. However, the two solutions
are electrically isolated from one another.

Bluetooth
Bluetooth is an open specification for wireless communication of data and voice. It is based on a low-cost
short-range radio link between two or more devices. The traditional example is a link between a mobile
phone and a laptop computer or a headset.

Bluetooth provides a fully digital link for communication between a master unit and one or more slave units.
The system provides a radio link that offers a high degree of flexibility to support various applications and
product scenarios. Data and control interface for a low power RF module is provided. The data rate is
regulated between the master and the slave.

The device Bluetooth is based on the BC4 BT ASIC (BTHFM1.0).

The UART1 interface handles the transfer of control and data information between the application processor
and the Bluetooth system. The PCM interface is used for audio data transfer between the RAP ASIC and the
Bluetooth system.

The following block diagram shows how the Bluetooth system is connected to the host side.
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FM radio
The second part of the BTHFM module contains the FM radio.

The antenna for the FM radio is provided by plugging in an external wired headset to the system connector.
It is not possible to listen to the FM radio without a wired headset connected. The FM radio is controlled by
I2C commands coming from RAP. The audio output of the FM radio is fed to the headset via the EM ASIC N2200,
so the rest of the phone can sleep while the FM radio is active.

USB
USB (Universal Serial Bus) provides a wired connectivity between a USB host PC and peripheral devices.

USB is a differential serial bus for USB devices. USB controller supports USB specification revision 2.0 with full
speed USB (12 Mbps). The device is connected to the USB host through the system connector. The USB bus is
hot plugged capable, which means that USB devices may be plugged in/out at any time.
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SIM interface
The device has one SIM (Subscriber Identification Module) interface. It is only accessible if battery is removed.
The SIM interface consists of an internal interface between RAP and EM ASIC (N2200), and of an external
interface between N2200 and SIM contacts.

The SIM IF is shown in the following figure:

Figure 91 SIM interface

The EM ASIC handles the detection of the SIM card. The detection method is based in the BSI line. Because of
the location of the SIM card, removing the battery causes a quick power down of the SIM IF.

The EM ASIC SIM1 interface supports both 1.8 V and 3.0 V SIM cards. The SIM interface voltage is first 1.8 V
when the SIM card is inserted, and if the card does not response to the ATR a 3 V interface voltage is used.

RS MMC interface
The reduced size (24 mm x 18 mm x 1.4 mm) multimedia card slot is located under the battery. The device
supports RS MMC hot insertion, which enables to remove/insert the card when the phone is powered on.

The RS MMC card is connected to the application processor MMC/SDIO2 (1.8 V) interface. The MMC interface is
shown in the following figure:
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Figure 92 MMC interface

The basic multimedia card concept is based on the following communication signals: CLK, CMD and DAT.

With each cycle of the CLK signal, one bit transfer on the DAT and CMD line is performed. The maximum CLK
frequency is 20 MHz.

CMD is a bi-directional command channel used for card initialization and data transfer commands. The CMD
signal has two operational modes: open-drain and push-pull mode. The open-drain mode is used for card
initialization and the push-pull mode for fast command transfer. CMD commands are sent by the host and
CMD responses are sent by the card.

DAT is a bi-directional data channel, which operates in the push-pull mode.

The detection of the RS MMC card removal/insertion is done via the RS MMC cover switch. The RS MMC cover
switch gives an interrupt to the SW when the cover is opened or closed. After opening the RS MMC cover lid
(RS MMC SW signal is connected to GND via cover switch), SW powers down the card and switches off the RS
MMC power supply (VSIM2). When the RS MMC cover lid is closed (RS MMC SW signal is internally connected in
the application processor to 1.8 V), the inserted card is identified.

Note: Removing the RS MMC while writing to it, may corrupt the data stored in the card.

Related information
• RS MMC interface connections (page 9–36)

Battery interface
The battery interface supports a 3-pole battery interface. The interface consists of three connectors: VBAT,
BSI and GND.

The BSI line is used to recognize the battery capacity by a battery internal pull down resistor.
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Figure 93 Battery pin order

Battery temperature is estimated by measuring separate battery temperature NTC via the BTEMP line, which
is located on the transceiver PWB, at a place where the phone temperature is most stable.

For service purposes, the device SW can be forced into local mode by using pull down resistors connected to
the BSI line.

Camera interface

Camera interface
The device uses a 2.0 megapixel camera module with a sensor resolution of 1600 x 1200. The following block
diagram shows how a CCP bus is used to transfer image data from the camera module to the phone engine.
This bi-directional control bus is a software-implemented I2C interface.

The camera regulator N1470 powers the digital parts of the camera, and a camera regulator N1471 is used
for powering the analogue parts.

A CAMVCTRL signal (Vctrl) is used for activating the camera module. When the Vctrl signal is Low, the module
enters the power on mode. When the signal is High, the module enters the power off mode.

A CAMCLK signal feeds the system clock for the camera module.

Camera construction
This section describes the mechanical construction of the camera module for getting a better understanding
of the actual mechanical structure of the module.

Table 16 Camera specifications

Sensor type CMOS Sensor

Photo detectors 1.9 million

F number/Aperture f/3.2

Focal length 4.8 mm (35 mm equivalent 37 mm)

Focus range 64 cm to infinity

Still Image resolutions 1600x1200, 640x480

Still images file format EXIF (JPEG), *.jpg

Video resolutions 352x288, 176x144. Both at 30 frames per second

Video clip length 10 seconds or free, maximal clip length in free mode
is 1 hour (limited by the data storing capabilities of
the device)

Video file format 3GPP, *.3gp

Exposure Automatic

White Balance Automatic
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Colours 16.7 million / 24-bit

Capture Modes Night mode, Sequence mode, self timer

Figure 94 Camera module cross section and assembly principle

Figure 95 Camera module bottom view including serial numbering

The camera module as a component is not a repairable part, meaning that the components inside the module
may not be changed. Cleaning dust from the front face is allowed only. Use clean compressed air.
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The camera module uses socket type connecting. For versioning, laser marked serial numbering is used on
the PWB.

The main parts of the module are:

• Lens unit including lens aperture.

• Infrared filter; used to prevent infrared light from contaminating the image colours. The IR filter is glued
to the EMI shielded camera body.

• Camera body; made of conductive metallized plastic and attached to the PWB with glue.

• Sensor array including DSP functions is glued and wire-bonded to the PWB.

• PWB, FR-4 type

• Passive components

• Camera protection window; part of the phone cover mechanics

• Dust gasket between the lens unit and camera protection window

Back camera slider detection switch
The back camera and flash LED have a cover slider, which position is detected with a slider switch (slider
sensor).

When the slider covers the back camera and flash LED (upper position), the slider switch is open circuit (not
pressed) and the application processor is connected to VIO. When the slider is slid down, the switch is pressed
and it connects the Helen pin mcbsp1_sync to GND (typical 160mV) and activates the back camera application

Figure 96 Slider switch connection

Flash LED
The device back camera has a flash LED (FLED), providing better lighting conditions in darker environments.
The same LED is also used as an indicator light to indicate video clip recording.
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The FLED is located next to the back camera under the camera slide. It cannot be used when the slide is closed,
and it is only used in the still image mode or as an indicator for video recording or image capturing. The
operating range of the FLED is approximately 1 m (~22 Lux) and 1.5 m (~9 Lux).

The connections between the main PWB and the FLED are implemented with a small PWB attached to the
device mechanics.

The FLED has four white LEDs connected in series in one module. The module also includes a lens with its
plastic housing.

The dimensions of the FLED are 6.5 x 7.5 x 3.5 mm.

Figure 97 Simplified flash LED connection
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User interface

Display interface

Display module mechanical concept

Figure 98 General diagram of the LCD module

Display features:

• 262,144 colours

• Partial display function Power saving by pausing display process on part of the screen.

• Built-in RAM capacity 176 rows x 208 lines x 18 bits = 658,944 bits

The display has two different operating modes:

1 Normal mode, Full screen, 260k colours

2 Partial idle mode, 8 colours and only part of the display is active

The module includes:

• FPWB foil including connector and discretes and driver circuits

• display panel (glass)

• drivers including display controller and 176 x 208 x 18 bits RAM

• backlight system: lightguide, LEDs and necessary optical sheets

• supporting mechanics

• metal frame (stainless steel)

• plastic frame

The interconnection between the LCD module and the Nokia engine is implemented with a 24-pin board-to-
board connector.

The display is controlled via a MeSSi-8 interface by the application processor. All MeSSi-8 signals go through
the EMC filtering ASIPs.
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The display module does not require any tunings in service.

Keyboard
The device keyboard is connected to the main PWB with a board-to-board connector.

The keymatrix has six rows and four columns. The voice key on the main PWB and the navigation key are
connected to the same keymatrix.

Table 17 Keymatrix

Key Row# kbc_# Column# kbr# Switch Ref.

0 6 0 U21

1 3 2 U19

2 2 1 U14

3 2 2 U16

4 5 3 U23

5 3 0 U18

6 3 3 U20

7 2 0 U15

8 2 3 U17

9 4 0 U22

* 4 1 U21

# 4 3 S2

END 5 0 U13

SEND 1 1 U1

EDIT 6 1 U11

CLEAR 6 2 U10

APPS 6 3 U12

Operator 5 2 U9

NAVI Left 0 2 S320

NAVI Right 0 3

NAVI Up 1 2

NAVI Down 1 3

NAVI Select 1 0

Left Soft Key 0 0 U7

Right Soft Key 0 1 U6

Camera 4 2 S1

Voice Not Required
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Keyboard layout

Figure 99 Keyboard layout

Display and keyboard backlight
The device has one LED Driver (SMPS) that is used to drive both display and keyboard LEDs.

The LED driver consists of two LED chains: display LED chain and keyboard LED chain. Both chains contain four
LEDs, eight in total.

The current adjustment of the driver is done from the display LED branch. The keyboard current also depends
on the display brightness.

Typically, keyboard LEDs are turned ON only in dark ambient lighting conditions.
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Table 18 LED driver control signals

From To Voltage Function

GenOut1 EM ASIC (N2300) R2302 (10k) 0V / 1.8V Maximum current
control (0V ->max
curr.)

GenOut2 EM ASIC (N2300) R2301 (4k7) 0V / 1.8V

PWM EM ASIC (N2300) J2309, N2301 PWM 0%-100%,
1.8V

Current PWM
control (16 steps)

GenOut3 EM ASIC (N2300) V2300 0V / 1.8V Keyboard LEDs ON
(1.8V) /OFF (0V)

ALS interface
Ambient Light Sensor (ALS) is located in the upper part of the phone. It consists of the following components:

• lightguide (part of the front cover)

• phototransistor (V4400) + resistor (R4401)

• NTC + resistors (R4400, R4402, R4403)

• EM ASIC (N2200)

Information on ambient lighting is used to control the backlights of the phone:

• Keypad lighting is switched on only when the environment is dark / dim

• Display backlights are dimmed, when the environment is dark / dim

The ambient light sensor itself is a photo transistor, which is temperature-compensated by an external NTC
resistor. N2200 reads the light sensor (LS) and temperature (LST) results.

ALS calibration is not possible in the service points. ALS is serviced by replacing faulty phototransistors.
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Figure 100 ALS HW implementation

Table 19 ALS resistor values

Symbol R1 R2 R3 R4 R5 R6 R7 NTC-res

Value 5 kOhm
15

kOhm
30

kOhm
50

kOhm
470

kOhm
100

kohm
470

kohm
47

kOhm

ASICs

RAP ASIC
RAP ASIC is a 2G Radio Application Processor.

In general RAP consists of three separate parts:

• Processor subsystem (PSS) that includes the main processor and related functions

• MCU peripherals that are mainly controlled by MCU

• DSP peripherals that are mainly controlled by DSP

RAP core voltage (1.4 V) is generated from the EM ASIC (N2300) VCORE and I/O voltage (1.8 V) is from the EM
ASIC (N2200) VIO. The core voltage in sleep mode is 1.05 V.

EM ASIC N2200
EM ASIC N2200 includes the following functional blocks:

• Start up logic and reset control

• Charger detection
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• Battery voltage monitoring

• 32.768 kHz clock with external crystal

• Real time clock with external backup battery

• SIM card interface

• Stereo audio codecs and amplifiers

• A/D converter

• Regulators

• Vibra interface

• Digital interface (CBUS)

EM ASIC N2300
EM ASIC N2300 includes the following functional blocks:

• Core supply generation

• Charge control circuitry

• Level shifter and regulator for USB/FBUS

• Current gauge for battery current measuring

• External LED driver control interface

• Digital interface (CBUS)

• Accessory supply voltage regulator

• Vout - accessory

Device memories

RAP memories NOR flash and SDRAM
The modem memory consists of 64 Mbit SDRAM and 64 Mbit NOR flash memories.

SDRAM is a dynamic memory for ISA (Intelligent Software Architecture) SW.

NOR is used for ISA SW code and PM data and CDSP (Cellular Digital Signal Processor) SW code.

Combo memory
The application memory of the device consists of NAND/DDR combo memory. The stacked DDR/NAND
application memory has 512 Mbits of DDR memory and 512 Mbits of flash memory. DDR DRAM memory is
stacked above the NAND flash.

Both NAND core and I/O voltages are 1.8 V generated by VIO.

Table 20 Supply voltages for combo memory interfaces

Parameter Symbol min max unit note

Supply
voltage

VBAT V Battery
voltage

Combo
memory
core
voltage

Vore 1.65 1.95 V Nominal
1.8V s
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Parameter Symbol min max unit note

Host I/O
supply
voltage1.8
V

VIO 1.71 1.89 V Nominal
1.8V

 Audio concept

Audio HW architecture
The functional core of the audio hardware is built around two ASICs: RAP CMT engine ASIC and the mixed-
signal ASIC.

The mixed-signal ASIC provides an interface for the transducers and the accessory connector. Because audio
amplifiers are also integrated into the ASIC, the only discrete electronics components needed for audio paths
are audio filtering components and EMC/ESD components.

There are three audio transducers:

• 8 mm dynamic earpiece

• 16 mm dynamic speaker

• electret microphone module

In addition to the audio transducers, the mixed-signal ASIC also provides an output for the dynamic vibra
component.

All galvanic audio accessories are connected to the system connector.

A Bluetooth audio module, which is connected to the RAP ASIC supports Bluetooth audio functionality.

There is also a separate application ASIC for Symbian applications.
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Figure 101 Audio block diagram

Internal microphone
Internal microphone is used for HandPortable (HP) and Internal HandsFree (IHF) call modes.

An analogue electret microphone is connected to N2200 Mic1P and Mic1N inputs via asymmetric electrical
connection.

The microphone is biased by N2200 MicB1 bias voltage output.

Figure 102 Internal microphone circuitry

External microphone
Galvanic accessories are connected to the system connector.
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The accessory audio mode is automatically enabled/disabled during connection/disconnection of dedicated
phone accessories.

External microphone circuitry is biased by N2200 MicB2 bias voltage output. The circuitry provides a
symmetrical connection for the microphone from the system connector connections, XMICN and XMICP, to
N2200 inputs, Mic2P and Mic2N.

Figure 103 External microphone circuitry (Pop-Port™ connects to the right side)

Internal earpiece
The internal earpiece is used in the HandPortable (HP) call mode. A dynamic 8 mm earpiece capsule is
connected to N2200 differential outputs EarP and EarN.

Figure 104 Internal earpiece circuitry

Internal speaker
The internal speaker is used in Internal HandsFree (IHF) call mode.

A dynamic 16 mm speaker is connected to N2200 outputs HFSpP and HFSpN.

The IHF amplifier integrated in N2200 is a Digital Pulse Modulated Amplifier (DPMA).

Figure 105 Internal speaker circuitry
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External earpiece
All galvanic accessories are connected to the system connector.

The accessory audio mode is automatically enabled/disabled during connection/disconnection of dedicated
phone accessories.

Figure 106 External earpiece circuitry (system connector connected on the right)

Vibra circuitry
The vibra circuitry is used for the vibra-alarm function.

The vibra motor is connected to the EM ASIC (N2200) VibraP and VibraN Pulse Width Modulated (PWM) outputs.

Figure 107 Vibra circuitry
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Pop-portTM connector
Pop-PortTM connector provides a fully differential 4–wire stereo line-level output connection and fully
differential 2-wire mono line-level or microphone level input connection.

The handsfree driver in EM ASIC (N2200) is meant for the headset.

The output is driven in a fully differential mode. In the fully differential mode, the handsfree pin is the
negative output and the HFCM pin is the positive output. The gain of the handsfree driver in the differential
mode is 6 dB.

The earpiece and headset signals are multiplexed so that the outputs cannot be used simultaneously.

Figure 108 External audio connector

Table 21 Audio connector pin assignments

Pin #/ Signal
name

Signal
description

Spectral range Voltage/
Current levels

Max or
nominal serial

impedance

Notes

1/ Charge V Charge DC 0-9V/ 0.85A

2/ GND Charge GND - 0.85A 100mΩ (PWB+
conn.)

3/ ACI ACI 1kbits/s Digital 0 / 47Ω Insertion &
removal
detection

2.5-2.78V

4/ Vout DC out DC 2.78V 70 mA 100mΩ (PWB+
conn.)

200mW

2.5V 90mA

9 / XMIC N Audio in 300-8k 1Vpp &

2.5-2.78VDC

10 / XMIC P Audio in 300-8k 1Vpp &

2.5-2.78VDC

11 / HEAR N Audio out 20-20k 1Vpp 10Ω

12 / HEAR P Audio out 20-20k 1Vpp 10Ω
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Pin #/ Signal
name

Signal
description

Spectral range Voltage/
Current levels

Max or
nominal serial

impedance

Notes

13 / HEAR R N Audio out 20-20k 1Vpp 10Ω Not conn. in
mono

14 / HEAR R P Audio out 20-20k 1Vpp 10Ω Not conn. in
mono

 Baseband technical specifications

External interfaces

External interfaces

Name of Connection Connector reference

USB X2001

Charger X2000

Headset X2001

SIM X2700

RS MMC X5200

Battery connector X2070

ACI interface electrical characteristics

Description Parameter Min Typ Max Unit Notes

Accessory detection

Headset
detection
threshold

1.75 1.9 2.05 V N2200
specific

Headset
detection
hysteresis

25 mV

Headset
detection
pull ups

1 2 4 uA

After Mbus is switched to HeadDet

High-level
input
voltage.

VIH 1.9 x VDDS 2.5/2.98 3.0 V N2200
specific

Low-level
input
voltage

VIL 0 0.2 0.7 x VDDS V
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Description Parameter Min Typ Max Unit Notes

High-level
output
voltage

VOH 2.4 2.5 2.6 V

Low-level
output
voltage

VOL 0 0.3 V

Rise/fall
time

tR/tF 12.5 ns

VOUT electrical characteristics

Description Parameter Min Max Typical Unit Notes

Vout
regulator
for
external
accessories

VOUT 2.43 2.57 2.5 V Max load
90mA

USB IF electrical characteristics

Description Parameter Min Max Unit Notes

Absolute
maximum
voltage on D+
and D-

VD+/D- -1 4.6 V USB
specification
revision 2.0

Supply voltage VBUS 4.4 5.25 V

Supply current:

Functioning IVBUS 100 mA

Suspended IVBUS 500 uA

Unconfigured IVBUS 100 mA

High-level
input voltage:

V

High (driven) VIH 2

High (floating) VIHZ 2.7 3.6

Low-level
input voltage

VIL 0.8 V

Differential
input
sensitivity

VDI 0.2 V |(D+) - (D-)|

Differential
input voltage
range

VCM 0.8 2.5 V Included VDI
range
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Description Parameter Min Max Unit Notes

Low-level
output voltage

VOL 0 0.3 V

High-level
output voltage
(driven)

VOH 2.8 3.6 V

Output signal
crossover
voltage

VCRS 1.3 2 V

FBUS interface electrical characteristics (between RAP and N2300)

Description Parameter Min Max Unit

High-level
input
voltage

VIH 0.7 x
VDDSHV2

VDDSHV2 V

Low-level
Input
voltage

VIL 0 0.3 x
VDDSHV2

V

High-level
output
voltage

VOH 0.8 x
VDDSHV2

VDDSHV2 V

Low-level
output
voltage

VOL 0 0.22 x
VDDSHV2

V

Rise/fall
time

tR/tF 0 25 ns

(VDDSHV2 = 1.8V)

Headset hook detection interface (XMICN) electrical characteristics

Description Min Typ Max Unit Notes

Hook detection
threshold 1

1.25 1.35 1.45 V Two fixed
thresholds
inside N2200.
Selectable by
SW

Hook detection
threshold 2

0.5 0.6 0.7 V

Hook detection
hysteresis

25 mV

Hook detection
pull ups

1 2 4 uA
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Audio signal electrical characteristics

Description Parameter Typ Unit Notes

XMIC N Audio in 1 Vpp DC Offset 2.5-2.78V

XMIC P Audio in 1 Vpp DC Offset 2.5-2.78V

HSEAR N Audio out 1 Vpp 10Ω nominal serial
impedance

HSEAR P Audio out 1 Vpp 10Ω nominal serial
impedance

HSEAR R N Audio out 1 Vpp 10Ω nominal serial
impedance

Not connected in
mono

HSEAR R P Audio out 1 Vpp 10Ω nominal serial
impedance

Not connected in
mono

SIM IF connections

Pin Signal I/O Engine connection Notes

C1 VSIM Out N2200 VSIM1 Supply voltage
to SIM card, 1.8
V or 3.0 V.

C2 SIMRST Out N2200 SIM1Rst Reset signal to
SIM card

C3 SIMCLK Out N2200 SIM1ClkC Clock signal to
SIM card

C5 GND - GND Ground

C7 SIMDATA In/Out N2200 SIM1DaC Data input /
output

RS MMC interface connections

Pin Signal I/O Engine connection Notes

1 RSV NC NC Reserved for
future use

2 CMD <-> D4800 MMC2_CMD Command/
Response

3 Vss1 GND Ground
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Pin Signal I/O Engine connection Notes

4 VDD <- N2200 VSIM2 VSIM2, supply
voltage 1.8
(Max 70mA)

5 CLK <- D4800 MMC2_CLK External clock
for the MMC
card, Max 20
MHz

6 Vss2 GND Ground

7 DAT <-> D4800 MMC2_DAT0 Bi-directional
data bus

- MMCDET -> D4800 btwake1(in)
[P10]

MMC card
detect

Charger connector and charging interface connections & electrical characteristics

Figure 109 Charger connector

Table 22 Charging interface connections

Pin Signal I/O Engine connection Notes

1 Vchar In N2300 VCharIn1, 2 Charging
voltage /
charger
detection,
Center pin

2 Charge GND Ground Charger
ground

Table 23 Charging IF electrical characteristics

Description Parameter Min Max Unit Notes

Vchar V Charge 0 9 V Center pin

Vchar I Charge 0.85 A Center pin

Charge GND 0.85 A

Threshold for
charging,
rising (N2300)

VMSTR+ 2.1 V Typical value
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Description Parameter Min Max Unit Notes

Threshold for
charging,
falling (N2300)

VMSTR- 1.9 V Typical value

Battery connector and interface connections & electrical characteristics

Figure 110 Battery connector

Table 24 Battery interface connections

Pin Signal I/O Engine connection Notes

1 VBAT -> EM ASIC N2200 VBAT Battery voltage

2 BSI -> EM ASIC N2200 BSI Battery size
indication
(fixed resistor
inside the
battery pack)

3 GND GND Ground

Table 25 Battery IF electrical characteristics

Description Parameter Max Unit

Operation voltage VIN 4.23 VDC

Current rating IIN 0.9 A

Internal interfaces

Internal interfaces

Name of Connection Connector reference

UI connector X4400

Display X4401

Back camera X1470

Front camera X1472

ALS V4400

Vibra M2100

Microphone B2100
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Name of Connection Connector reference

Earpiece B2101

IHF speaker B2102

UI connections

Table 26 User interface connections

Pin Signal I/O Engine connection Notes

1 GND GND

2 LED+ <- N2301 VLEDOUT2

Discrete
Backlight SMPS
(controlled by
EM ASIC N2300)

3 Col2 -> D4800 Kbc_2

4 LED-

->

R2305 + V2300 SETCURR2

Serial resistor +
Transistor
switch
(controlled by
EM ASIC N2300)

5 Col1
->

D4800 Kbc_1
Voice switch
connection

6 GND GND

7 Row3 -> D4800 Kbr_3

8 Row2 -> D4800 Kbr_2

9 Row1 -> D4800 Kbr_1

10 Row6 -> D4800 Kbr_6

11 Row0 -> D4800 Kbr_0

12 Col0 -> D4800 Kbc_0

13 Row5 -> D4800 Kbr_5
Voice switch
connection

14 Row4 -> D4800 Kbr_4

15 GND GND

16 Col3 -> D4800 Kbc_3

Keyboard interface electrical characteristics

Description Parameter Min Typ Max Unit Notes

High-level
input voltage

VIH 0.65* VDDS VDDS 0.3+ VDDS V Row

Low-level
input voltage

VIL -0.3 0 0.35* VDDS V Row
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Description Parameter Min Typ Max Unit Notes

High-level
output
voltage

VOH 1.62 VDDS 1.98 V Column

Low-level
output
voltage

VOL 0 0.45 V Column

(VDDS = 1.8V)

Display connector and interface connections

Figure 111 Display connector

Table 27 Display interface connections

Pin Signal I/O Engine connection Notes

1 GND

2
WRX

-> D4800 Lcdwrx
Write Enable
(active low)

3 GND

4 D0 <-> D4800 Lcdda0 Data

5 D1 <-> D4800 Lcdda1 Data

6 D2 <-> D4800 Lcdda2 Data

7 D3 <-> D4800 Lcdda3 Data

8 GND

9
VDDI

<- N2200 VIO
Interface
voltage

10 VDD <- N2200 VAUX Core voltage
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Pin Signal I/O Engine connection Notes

11 GND

12

LEDin

<- N2301 VLEDOUT1

N2301 is
controlled by
N2300

13 LEDout -> R2304 SETCURR1 Sink resistor

14 GND

15
CSX

<- D4800 Lcdcsx
Chip Select
(active low)

16

D/CX

<- D4800 Lcdcmd

Data/
Command
select
(high=data,
low
=command)

17 GND

18 D7 <-> D4800 Lcdda7 Data

19 D6 <-> D4800 Lcdda6 Data

20 D5 <-> D4800 Lcdda5 Data

21 D4 <-> D4800 Lcdda4 Data

22 TE -> D4800 Te Tearing Effect

23
RDX

<- D4800 Lcdrdx
Read Enable
(active low)

24
RESX

<- D4800 Gpio_60
Reset (active
low)

Camera interface connections and electrical characteristics

Table 28 Camera interface connections

Pin Signal I/O Engine connection Notes

1 GND

2 SDA <-> D4800 sda
I2C serial control
bus data

3 D+ -> D4800 Ccpdap

Differential serial
data, positive
node

4 SCL <- D4800 scl
I2C serial control
bus clock

5 D- -> D4800 Ccpdan

Differential serial
data, negative
node
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Pin Signal I/O Engine connection Notes

6 CAMCLK <- D4800 ExtClk
System clock for
camera module

7 VDDI <-

N1470
1.8V
regulator VOUT

Camera Digital
Voltage

8 GND

9 CLK+ -> D4800 Ccpclkp

Differential serial
clock, positive
node

10
CAMVCTR
L <- D4800 VCtrl

Camera module
activating signal

11 CLK- -> D4800 Ccpclkn

Differential serial
clock, negative
node

12 VDD <-

N1471
2.8V
Regulator VOUT

Camera analogue
Voltage

13 Strobe ->
No Connect. Signal
Unused.

14 GND

Table 29 Camera CCP IF electrical characteristics

Description Parameter Min Typ Max Unit Notes

Common
mode
voltage

VCMF 0.7 0.75 0.85 V -1

Differential
voltage
swing

VOD 130 185 250 mV -2

Operating
frequency

fCLK 120 160 MHz SW controls
frequency

Differential
rise and fall
time

300 800 ps -3

Note:

• Common mode voltage is a mean value of high and low states of one single-ended signal.

• Differential voltage swing is differential amplitude between signals of differential pair.

• Differential transitions should be only measured with good equipment (bandwidth > 1 GHz),
otherwise results will seem too slow.
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Table 30 Camera supply voltage characteristics

Description Parameter Min Typ Max Unit

Camera analogue
voltage

VDD 2.65 2.78 2.91 V

Camera digital
voltage

VDDI 1.7 1.8 1.91 V

Table 31 Camera control IF electrical characteristics

Description Parameter Min Typ. Max Unit Notes

SDA, SCL,
Vctrl, ExtClk

VIH 1.5 1.8 VD
D

V High-level input
voltage

SDA, SCL,
Vctrl, ExtClk

VIL 0 - 0.5
4

V Low-level input
voltage

SDA VOL 0 - 0.4 V High-level output
voltage

Regulator
Enable

VOH 1.3
5

1.8 2.3
V

V D4800 GPIO High-
level output
voltage

Cam_strobe VOH 0.8
x
VDD

- VD
D

High-level output
voltage

Cam_strobe VOL 0 - 0.4 V Low-level output
voltage

ExtClk fExtClk 9.6 MHz SW controls
frequency

SDA, SCL tR 30
0

ns Rise time

Flash LED interface and electrical characteristics

Table 32 Flash LED interface connections

Signal name From To Description

GPIO28 D4800 N1471 Indicator mode enable
signal

ARMIO4 D4800 N1471, V1472 Flash mode enable test
signal (only test use)

VBAT Battery N1471 Battery nominal voltage

STROBE Camera N1471, V1472 Flash light enable signal
from back camera
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Table 33 Flash LED interface electrical characteristics

Description Parameter Min Typ Max Unit

GPIO28 GPIO output 1.72 1.8 1.92 V

ARMIO4 GPIO output 1.72 1.8 1.92 V

STROBE Strobe signal
output

2 - 2.5 V

Slider switch electrical characteristics

Signal name From To Low value High value Description

GPIO53 Application
processor

S5202 160 mV 1.8 V Slider switch
cover status
signal.

Back-up battery interface connections and electrical characteristics

Table 34 Back-up battery connections

Pin name I/O Connection Notes

L2207,
VBack

-> N2200,
VBack

Back-up battery G2200 is
connected to N2200 via coil

Table 35 Back-up battery electrical characteristics

Description Parameter Min Typ Max Unit

Back-Up
Battery
Voltage

Vback 0 2.5 2.7 V

 RF description

Receiver

Introduction to receiver functionality
Receiver functions are implemented in an RF ASIC.

The receiver is a linear direct conversion receiver consisting of separate front ends (LNA (Low Noise Amplifier)
and demodulator) for each supported system. After the demodulators, the signal paths are combined to one
common BB path.

GSM receiver
As GSM Rx branches are functionally identical, the following description is applicable to all of them.

The received signal goes from the GSM antenna to the antenna switch module. The switch module contains
PIN diode switches for a band and Rx/Tx selection and also Rx SAW filters.

The antenna switch module is followed by integrated LNAs (Low Noise Amplifier) residing in an RF ASIC.

The LNAs are followed by demodulators which downconvert the signal to baseband I and Q signals. The
channel select filter is set to 115 kHz.
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Transmitter

Introduction to transmitter functionality
Transmitter functions are implemented in an RF ASIC. The ASIC contains a BB frequency low pass filter, which
is tunable according to the signal bandwidth of the system in use.

In addition, the ASIC contains separate RF paths comprising a final frequency IQ modulator and VGA amplifiers.

GSM transmitter functionality
An RF ASIC receives an analogue IQ modulated signal from digital BB, which is first low pass filtered with
filter corner frequency set to approximately 200 kHz. After the filter, the signal is routed to the GSM modulator.

After the VGA stage the signal exits the RF ASIC. In case of GSM1800/1900 the signal goes directly to the GSM
PA module. In case of EGSM900 (and GSM850), the PA module is preceded by a SAW filter. After the filter, the
signal is fed to the GSM PA module. Finally, the signal is routed via the antenna switch to the antenna.

Figure 112 GSM transmitter

GSM power control
A closed control loop comprise an integrated power detector (in PA module) and an error amplifier. The error
amplifier resides in N7501, and it controls the transmitter power of GSM.

GSM PA module
A single GSM/EDGE PA module contains two separate amplifier chains, one for EGSM900 (and GSM850) and
another for GSM1800/1900. Both amplifiers have a battery supply connection and two bias current inputs.

Frequency synthesizers
RF has separate synthesizers for Rx and Tx. Both synthesizers consist of:

• PLL (Phase-Locked Loop)
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• loop filter

• VCO (Voltage Controlled Oscillator)

• balun

The VCO frequencies are locked by PLLs into a reference oscillator, VCTCXO (Voltage Controlled Temperature
Compensated Crystal Oscillator).

The PLLs are located in RF ASICs and controlled via RFBus.

Reference oscillators
A 38.4MHz VCTCXO is used as a reference oscillator for the frequency synthesizers.

Regulators
RF ASICs contain integrated regulators to supply regulated voltages for their internal circuitry and other RF
parts. Rx VCO supply is got via a switch from an RF ASIC VR1 regulator. VCO can be switched on and off by
controlling the switch via RFBus.

Supply voltage for the VCTCXO is provided by a BB mixed mode ASIC. The same supply is used for reference
clock input buffers, output buffers and for the digital control blocks of both RF ASICs.

Other supplies, like 4.7 V supply for PLL charge pumps and bias reference (VREFRF01) are also provided by
the BB mixed mode ASIC.

Figure 113 RF supply connections from the BB mixed mode ASIC
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 Frequency mappings

EGSM900 frequencies
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GSM1800 frequencies
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A/D-converter Analog-to-digital converter

ACI Accessory Control Interface

ADC Analog-to-digital converter

ADSP Application DPS (expected to run high level tasks)

AGC Automatic gain control (maintains volume)

ALS Ambient light sensor

AMSL After Market Service Leader

ARM Advanced RISC Machines

ARPU Average revenue per user (per month or per year)

ASIC Application Specific Integrated Circuit

ASIP Application Specific Interface Protector

B2B Board to board, connector between PWB and UI board

BB Baseband

BC02 Bluetooth module made by CSR

BIQUAD Bi-quadratic ,type of filter function)

BSI Battery Size Indicator

BT Bluetooth

CBus MCU controlled serial bus connected to UPP_WD2,UEME and Zocus

CCP Compact Camera Port

CDSP Cellular DSP (expected to run at low levels)

CLDC Connected limited device configuration

CMOS Complimentary metal-oxide semiconductor circuit (low power consumption)

COF Chip on Foil

COG Chip on Glass

CPU Central Processing Unit

CSR cambridge silicon radio

CSTN Color Super Twisted Nematic

CTSI Clock Timing Sleep and interrupt block of Tiku

CW Continuous wave

D/A-converter Digital-to-analouge converter

DAC Digital-to-analouge converter

DBI Digital Battery Interface

DBus DSP controlled serial bus connected between UPP_WD2 and Helgo

DCT-4 Digital Core Technology

DMA Direct memory access

DP Data Package
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DPLL Digital Phase Locked Loop

DSP Digital Signal Processor

DtoS Differential to Single ended

EDGE Enhanced data rates for global/GSM evaluation

EGSM Extended GSM

EM Energy management

EMC Electromagnetic compability

EMI Electromagnetic interference

ESD Electrostatic discharge

FCI Functional cover interface

FPS Flash Programming Tool

FR Full rate

FSTN Film compensated super twisted nematic

GND Ground, conductive mass

GPIB General-purpose interface bus

GPRS General Packet Radio Service

GSM Group Special Mobile/Global System for Mobile communication

HF Hands free

HFCM Handsfree Common

HS Handset

HSCSD High speed circuit switched data (data transmission connection faster than GSM)

HW Hardware

I/O Input/Output

IBAT Battery current

IC Integrated circuit

ICHAR Charger current

IF Interface

IHF Integrated hands free

IMEI International Mobile Equipment Identity

IR Infrared

IrDA Infrared Data Associasion

ISA Intelligent software architecture

JPEG/JPG Joint Photographic Experts Group

LCD Liquid Crystal Display

LDO Low Drop Out

LED Light-emitting diode
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LPRF Low Power Radio Frequency

MCU Micro Controller Unit (microprocessor)

MCU Multiport control unit

MIC, mic Microphone

MIDP Mobile Information Device Profile

MIN Mobile identification number

MIPS Million instructions per second

MMC Multimedia card

MMS Multimedia messaging service

NTC Negative temperature coefficient, temperature sensitive resistor used as a
temperature sensor

OMA Object management architechture

OMAP Operations, maintenance, and administartion part

Opamp Operational Amplifier

PA Power amplifier

PDA Pocket Data Application

PDA Personal digital assistant

PDRAM Program/Data RAM (on chip in Tiku)

Phoenix Software tool of DCT4.x

PIM Personal Information Management

PLL Phase locked loop

PM (Phone) Permanent memory

PUP General Purpose IO (PIO), USARTS and Pulse Width Modulators

PURX Power-up reset

PWB Printed Wiring Board

PWM Pulse width modulation

RC-filter Resistance-Capacitance filter

RF Radio Frequency

RF PopPort TM Reduced function PopPortTM interface

RFBUS Serial control Bus For RF

RSK Right Soft Key

RS-MMC Reduced size Multi Media Card

RSSI Receiving signal strength indicator

RST Reset Switch

RTC Real Time Clock (provides date and time)

RX Radio Receiver
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SARAM Single Access RAM

SAW filter Surface Acoustic Wave filter

SDRAM Synchronous Dynamic Random Access Memory

SID Security ID

SIM Subscriber Identity Module

SMPS Switched Mode Power Supply

SNR Signal-to-noice ratio

SPR Standard Product requirements

SRAM Static random access memory

STI Serial Trace Interface

SW Software

SWIM Subscriber/Wallet Identification Module

TCXO Temperature controlled Oscillator

Tiku Finnish for Chip, Successor of the UPP, Official Tiku3G

TX Radio Transmitter

UART Universal asynchronous receiver/transmitter

UEME Universal Energy Management chip (Enhanced version)

UEMEK See UEME

UI User Interface

UPP Universal Phone Processor

UPP_WD2 Communicator version of DCT4 system ASIC

USB Universal Serial Bus

VBAT Battery voltage

VCHAR Charger voltage

VCO Voltage controlled oscillator

VCTCXO Voltage Controlled Temperature Compensated Crystal Oscillator

VCXO Voltage Controlled Crystal Oscillator

Vp-p Peak-to-peak voltage

VSIM SIM voltage

WAP Wireless application protocol

WD Watchdog

XHTML Extensible hypertext markup language

Zocus Current sensor, (used to monitor the current flow to and from the battery)
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